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Introduction

1

Archive Manager for Exchange provides the most flexible and effective way to collect, archive,

search and secure all you organization’s email from one central location. You can control the

retention policy of archived emails by moving emails to inexpensive locations as their relevance

changes with the option to delete old messages unless they are on legal hold. With robust

version control, any previous version of an archived email can be restored at any time along with

its attachments. Archive Manager for Exchange also offers online management of archived

emails, as well as mobile and offline email access to users on the road.

The primary features of Archive Manager for Exchange and HSM are as follows:

 Archive Manager for Exchange - email archiving engine that includes the windows services and

the Archive Manager for Exchange Administration Center (AMAC). Archive Manager for

Exchange has the following components:

o Application Server - contains the core functionality of the Archive manager for Exchange.

o Administrative tool - installs the Archive Manager for Exchange Administration Center

(AMAC). The AMAC can be installed as a standalone application on other computers as well

and allows several administrators to manage Archive Manager for Exchange deployment.

o PST Importer - installer files for the PST Importer feature which import and archives emails

from PST files. PST Importer can be set up to work with the PST Gatherer feature that runs

either as an application or a service. It assists users with gathering PST files that are stored in

distributed locations like network shares in addition to local drives.

o Forms Installer - installer files and template which are used to publish Archive Manager forms

to the Organizational Forms Library or the Personal Forms Library. It can only be used on a

computer where Outlook is running.

o Auditing - allows administrators to log defined user actions in the email archive like

archiving, retrieving, restoring and search history that were initiated from Outlook or

ArchiveWeb. This feature can be installed on the Archive Manager for Exchange server or on

a separate machine.

o Monitoring service - Monitors other Archive Manager services and alerts the administrator via

notification email if necessary. Notification emails are sent only if an error occurs.

o Documentation - Offline documentation about the product.

 Hierarchical Storage Manager (HSM) - a data storage system for managing your email archive

store as well as all company data on one or more file-servers. HSM ensures that files with

identical content are stored only once regardless of where the original file is located.

The following optional features are integrated with the Archive Manager for Exchange product

installer:
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 Archive Manager Search - keyword search engine capable of searching archived emails.

 Archive Manager ArchiveWeb  - online archive interface with advanced search and reporting

functionality.

The following optional features are included as separate installers in the download package:

 Archive Manager OWA Extension - feature that is installed on the Microsoft Exchange Server to

provide Outlook Web Access (OWA) for archived emails to end-users.

 Archive Manager Universal Access - allows mobile users, Mac users and Linux users to work

with archived emails.

 Archive Manager SMTP Service - allows processing of messages from an external email server

(O365, Gmail, Exchange, etc.) into Archive Manager for Exchange.

· Archive Manager Outlook Addin - gives authorized users the ability to archive and restore

emails with the Outlook desktop client.

· Archive Manager PST Gatherer Setup - automated extension to PST importer.

This advanced install guide describes the installation of the primary features of Archive Manager

for Exchange in a distributed environment. To allow load balancing and redundancy for large

email volumes, Archive Manager provides you with the ability to configure several Archive

Manager servers. You can add additional features as required.

About the email archive and retrieval process
When emails are archived, Archive Manager for Exchange uses shortcuts to replace archived

emails in the on-premise or online Microsoft Exchange mailboxes. Email shortcuts require very

little space, reducing your email storage by up to 80% and email backup time by 50%. Messages

remain available to end-users who can work with them as usual. This helps your end-users access

all their data while reducing the need to set mailbox quotas and removing the dependency on

PST files.

When a user clicks a shortcut to an archived email, Archive Manager for Exchange passes the

information from the shortcut to HSM which restores the email from the store.

HSM uses the Single-instance storage (SIS) service that takes multiple copies of the content and

replaces them with a single shared copy. It allows version control, eliminates data duplication,

and increases storage and retrieval efficiency.
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System Requirements

2

The requirements described below  are applicable for installing the Archive Manager for

Exchange application components, and are compatible with the following Microsoft Exchange

servers:

· Microsoft Exchange Server 2016

· Microsoft Exchange Server 2019

· Microsoft 365 (Exchange Online)

NOTE: System requirements for optional components of the Archive Manager for Exchange

are described in the corresponding document for each optional component. You may have

to exclude users of Archive Manager for Exchange from modern authentication policies, in

on-premise environments with Exchange 2019 CU13 and later. Contact Quest Technical

Support Resources for more information.

Hardware

Component Minimum specification Recommended specification

Number of Processor Cores 4 8

Main Memory 4 GB 12 GB

Hard Disk 10 GB 10 GB

NOTE: The application, log files and cache folders require 10 GB of HDD space. If the

Archive Manager for Exchange server includes the database, and is used as a local storage

for archived messages as well, then the the Hard Disk size must be revised upwards to add

more space for the database and the file store.

Operating System

· Windows Server 2016

· Windows Server 2019

· Windows Server 2022
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NOTE: Latest updates and service packs for servers are recommended.

Windows Server Roles

· Web Server (IIS)

o Web Server > Common HTTP Features > HTTP Redirection

o Web Server > Performance > Dynamic Content Compression 

o Web Server > Security > Basic Authentication

o Web Server > Security > Windows Authentication

o Web Server > Application Development

§ .NET Extensibility 4.5 or later

§ ASP.NET 4.5 or later

o Management Tools > IIS 6 Management Console

o Management Tools > IIS 6 Management Compatibility > IIS 6 Metabase Compatibility

o Management Tools > Management Service 

Windows Features

· Remote Server Administration Tools

o Role Administration Tools > AD DS and AD LDS Tool > Active Directory module for Windows

PowerShell

NOTE: Ensure that PowerShell can communicate between the Archive Manager server

and the Exchange server and between the Archive Manager server and the domain

controller

· .NET Framework 4.8 Features / .NET Framework 4.8 

· .NET Framework 4.8 Features / ASP.NET 4.8 

· .NET Framework 4.8 Features / WCF Services (all checkboxes under this item)

Redistributable packages

· Microsoft Visual C++ 2013 Redistributable Package (x64)

· Microsoft Visual C++ 2015-2022 Redistributable Package (x64)

· Microsoft Visual C++ 2015-2022 Redistributable Package (x86)



9
System Requirements

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

.NET 4.8

Download and install .NET Framework 4.8 from the following link: 

https://dotnet.microsoft.com/en-us/download/dotnet-framework/thank-you/net48-web-

installer 

Microsoft Outlook

The table below identifies the mail clients that are supported for use together with each version

of Exchange. Supported clients are identified by a check mark (ü)

Client Exchange 2019 Exchange 2016

Microsoft 365 ü ü

Outlook 2021 (32-bit) ü ü

Outlook 2019 (32-bit) ü ü

Outlook 2016 (32-bit)
ü 1 ü 1

NOTE: 1 - Supported with the latest Office service pack and public updates.

Database Servers and Drivers

· Microsoft SQL Server 2014 to Microsoft SQL Server 2022

o Microsoft OLE DB Driver 18 for SQL Server, or newer

· Azure SQL Database

· Oracle 19c

o Oracle client (x86 or x64)

Web Browsers

Web browsers are required for ArchiveWeb and is included here because ArchiveWeb is installed

automatically if Express installation is considered.

· Microsoft Edge current version

· Mozilla Firefox current version

· Chrome current version

· Opera current version

https://dotnet.microsoft.com/en-us/download/dotnet-framework/thank-you/net48-web-installer
https://dotnet.microsoft.com/en-us/download/dotnet-framework/thank-you/net48-web-installer
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Additional Information

· Installation of Archive Manager application components on a Microsoft Exchange Server or

Domain Controller are not supported.

· The software installs web applications in the Default Web Site. This could cause conflict with

other applications like Microsoft CRM or Microsoft SharePoint. To change the installation

website, manual changes are required after the installation. Please contact Technical support

in such cases.

· Archive Manager for Exchange is fully supported in a virtualized environment.
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Deployment Plan

3

The advanced installation of Archive Manager for Exchange is used by large organizations that

deploy a distributed server topology to increase the efficiency and throughput of email archival

and retrieval. In the illustration below, a conceptual distributed deployment plan is presented in

a single domain called democorp.com that is managed by a domain controller labeled AMXDC.

In this domain, there is a singled on-premise Microsoft Exchange server labeled AMXEXCH that

manages the communication for all users and groups in the domain. Users have access to an

online Exchange server (O365) as well, labeled democorp.onmicrosoft.com that has a separate

active directory which may or may not be integrated with the on-premise active directory. An

optional feature called Archive Manager OWA Extension can be installed on the on-premise

Exchange server so that users can view regular and archived emails online. 

The servers that comprise the distributed topology of Archive Manager for Exchange are labeled

for ease of reference, and will be used throughout this guide to describe the preparation,

installation, configuration, and verification of the deployment.

Figure 1. Topology for a distributed deployment of Archive Manager for Exchange

The roles of the different servers are explained below:
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AMXDB

This is a dedicated database server that hosts the various databases that are used by the Archive

Manager for Exchange features to manage the archival and retrieval of emails. A single database

server can host all the databases used by Archive Manager for Exchange. Organizations that have

email volumes in excess of one million, are advised to distribute the databases across dedicated

database servers as follows: MAMEXCH for the Archive Manager for Exchange feature,

MAMAUDIT for the Auditing feature of Archive Manager for Exchange, and MAMHSM, MAMINDEX

and MAMSEARCH for the HSM and Archive Manager Search features.

AMXHSM

This server hosts two features of the Archive Manager for Exchange: the Hierarchical Storage

Manager (HSM) and Archive Manager Search. 

HSM is a data storage system for managing archived emails and files. HSM can manage a larger

network of servers in organizations that use dedicated file servers. When the Archive Manager

for Exchange server (AMXSVR-A) sends emails to HSM, they are immediately compressed and

archived. When a user requests an archived email, HSM immediately decompresses the archived

email and returns it to the Exchange server where the request originated, through the Archive

Manager for Exchange server (AMXSVR-R). The Exchange server returns the email to the user.

Archive Manager Search is a keyword search engine capable of searching archived emails and

files. To increase the search efficiency archived emails are indexed. Users can search emails in

their mailboxes and folders. Users can search the mailboxes and folders of other users as well if

they have the requisite permissions.

AMXSVR-A

This server hosts the Archive Manager for Exchange application server with the Archive Server

role that defines the dedicated archival function of this server. This server is commonly called the

Archive server.

AMXSVR-R

This server hosts the Archive Manager for Exchange application server with the Retrieve Server

role that defines the dedicated retrieval function of this server. This server is commonly called

the Retrieve server.
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About User Accounts

4

Before you begin installing Archive Manager for Exchange, you must identify or setup three types

of user accounts to ensure a successful installation and usage experience of the Archive Manager

for Exchange.

Installer account - Enterprise user account that has administrator access to the various servers and

is used to install the application features.

Superuser account - Domain user account that is used to run the windows services, and

administer the application. The superuser account needs additional privileges and configuration

to be able to communicate with the Microsoft Exchange Server. The advanced installation wizard

manages all the setup and configuration steps that are required, but if you choose to do a manual

installation, see Manual Installation for a summary of steps to setup a superuser.

Database user account - For Oracle database authentication or SQL Server authentication on

Microsoft SQL Server. Does not have to be a domain user account but this user account needs

elevated privileges to setup and access the databases . You don't have to setup this account if you

plan to use Windows authentication with a Microsoft SQL Server.

Considerations for the database user

Archive Manager for Exchange supports either the Microsoft SQL Server or the Oracle database.

The database user considerations for each database is also dependent on the authentication

mode as described below.

For SQL Server

Windows Authentication

The domain user that is selected must be added to the database with the sysadmin role. This user

will be automatically assigned the dbo user account by SQL Server. You can then use dbo as the

username for database connection credentials which is preferred.

NOTE: For Windows authentication, we recommend the superuser account be added to the

database with the sysadmin role. Descriptions in this guide use dbo as a sample login

username and assumes it is the superuser account.

When a user connects through a Windows user account, SQL Server validates the account name

and password using the Windows principal token in the operating system. This means that the

user identity is confirmed by Windows. SQL Server does not ask for the password, and does not

perform the identity validation. Windows Authentication is more secure than SQL Server

Authentication.
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SQL Server Authentication

You must create a database user in SQL Server to access the database with the sysadmin role.

When using SQL Server Authentication, logins are created in SQL Server that are not based on

Windows user accounts. Both the username and the password are created by using SQL Server

and stored in SQL Server. When using SQL Server Authentication, you must set strong passwords

for all SQL Server accounts.

For Oracle

Archive Manager for Exchange does not support Windows Authentication for Oracle database

servers. You can use the credentials of any existing user with the sysdba role or create a database

user with the sysdba role.
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Advanced Installation

5

Advanced installation uses the installation wizard to install Archive Manager for Exchange and

associated features on dedicated servers as described in the Deployment Plan. The installation

wizard guides you through the installation of each feature on the various servers. In addition to

the installation of the features, the installer wizard also helps you to verify, install and set up the

prerequisites and accounts that you would have to do manually to prepare the environments for

the installations.

NOTE: Some organizations prefer a more granular control on the installation process. You

can choose to install all the features manually. For more information about the manual

installation process, see the chapter Manual Installation.

In this chapter:

· Setup the Superuser Account

· Prepare the Application Servers

o Steps to download the install media

o Steps to install the prerequisites

o Steps to install Microsoft Outlook

· Install the Application Features

o Install HSM and Archive Manager Search

o Install Archive Manager for Exchange (Archive server)

o Install Archive Manager for Exchange (Retrieve server)

For next steps after you complete the advanced installation, see Application Configuration.

Setup the Superuser Account
A superuser account is a windows account with administrator privileges to work with Archive

Manager for Exchange administration tools, run services, manage databases, manage extensions.

It also has elevated privileges to interact with the on-premise or online Microsoft Exchange

servers.

In this topic:

1. Steps to create the superuser account
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2. Steps to add the superuser to the Administrators group of the servers

3. Steps to add the superuser as a database user with sysadmin role (for Windows authentication

only)

NOTE: There are more configuration steps necessary to grant elevated permissions to the

superuser. When you use the Advanced Installation option from the Archive Manager for

Exchange installation wizard, all the other configurations are automatically completed for

you. For the complete set of configuration steps, see Setup the Superuser Account in the

manual installation chapter of this guide.

Steps to create a superuser account
1. Log in to the domain controller.

2. Navigate to Start > Windows Administrative Tools > Active Directory Users and Computers.

3. From the Console Tree, expand the domain node.

4. Click the Users container. The list of users opens in the right-hand pane.

5. Click the Action menu and select New > User. The New Object - User window opens.

6. Verify that Create in title indicates the appropriate domain name and container, and then

enter the details of the superuser. For example:

a. Full name: MAM Administrator

b. User logon name: mamadmin@democorp.com

7. Click Next. 

8. Enter the password and confirm it. Then select Password never expires. Uncheck all other

check boxes.
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9. Click Next.

10. Verify the information and click Finish.

Steps to add the superuser to the Administrators
group of the servers
The superuser must be able to run windows services and accomplish tasks that require

administrator privileges on the Archive Manager for Exchange feature servers. Follow the steps

described below to grant administrator privilege to the superuser on each feature server.

1. Log in to each server with its local administrator credentials.

2. Navigate to Start > Windows Administrative Tools > Computer Management 

3. From the Console Tree, navigate to the System Tools > Local Users and Groups > Groups

container.

4. From the list of groups in the right-hand pane, right-click Administrators and select Properties

from the context menu. The Administrators Properties window opens.

5. Click Add.

6. In the Enter the object name to select field, enter the user logon name of the super user. For

example, enter sales\mamadmin

7. Click Check Names to verify the logon name.



18
Advanced Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

8. Click OK to add the superuser to the Administrator group.

9. In the Administrators Properties window, click Apply and OK to complete the process.

TIP: Log out of the server and log in again with the superuser's credentials to quickly verify

that the superuser can access the server.

Steps to add the superuser as a database user with
sysadmin role
If you plan to use Windows authentication with a Microsoft SQL Server database, follow the steps

described below:

1. Log in to the database server with your database administrator credentials.

2. Open the SQL Server Management Studio on your SQL server database server.

3. Log in to the server instance for Archive Manager for Exchange databases.

4. Open the Security folder.

5. Right-click on the Logins folder and select  New Login. The Login - New user properties window

appears.

6. If you want to assign rights to a Windows account, select Windows authentication.

7. Provide the login name in the text box. You can use the Browse button to select an existing

account if you chose Windows authentication (eg. democorp\mamadmin)

8. In the user properties window, click Server Roles from the Select a page panel and select the

check box Sysadmin.

9. Click OK to create the account.

NOTE: Follow the above steps to add the installer account (eg. democorp\domadmin) with

the Sysadmin role.
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Prepare the Application Servers

For the Archive Manager Database server (AMXDB)

See the System Requirements and About User Accounts chapters for preparing database servers.

For the HSM and Search server (AMXHSM)

· Steps to install the prerequisites

· Steps to download the install media

For the Archive server (AMXSERVER-A)

· Steps to install the prerequisites

· Steps to install Microsoft Outlook

· Steps to download the install media

For the Retrieve server (AMXSERVER-R)

· Steps to install the prerequisites

· Steps to install Microsoft Outlook

· Steps to download the install media

Steps to install the prerequisites

These steps are optional and are included if you want to install them yourself. The installer

verifies prerequisites.

1. Log in with the credentials of the local administrator. 

2. Open PowerShell as an Administrator.

3. To install the recommended windows roles and features for individual components that may

be distributed across other servers run the following PowerShell commands:

Archive Manager for Exchange (for Archive and Retrieve servers)

Install-WindowsFeature -Name Web-Server, Web-Http-Redirect,
Web-Dyn-Compression, Web-Windows-Auth, Web-Basic-Auth,
Web-Metabase, Web-Mgmt-Service, RSAT-AD-PowerShell,
NET-Framework-45-Features, NET-Framework-45-ASPNET,
Web-Net-Ext45, Web-Asp-Net45, NET-WCF-Services45, Web-Asp-Net
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HSM

Install-WindowsFeature -Name Web-Server, NET-Framework-Features

Search

Install-WindowsFeature -Name NET-Framework-Features

ArchiveWeb

Install-WindowsFeature -Name NET-WCF-HTTP-Activation45, Web-Server,
Web-Static-Content, Web-Http-Redirect, Web-Stat-Compression,
Web-Dyn-Compression, Web-Windows-Auth, Web-Basic-Auth

NOTE: These PowerShell commands are compatible with a Window 2016 operating

system. Please refer to the System Requirements chapter to modify the script for other

supported Windows operating systems or install them manually.

4. Install the database drivers. For Microsoft SQL Server, the database driver is available in the

folder <installation folder>\Archive Manager Installation Package\Install.

5. Install the redistributable packages required for your operating system. These files are

available in the folder <installation folder>\Archive Manager Installation

Package\Install.

Steps to install Microsoft Outlook

The Archive Manager Server communicates with Microsoft Exchange on-premise servers via MAPI

or EWS and Microsoft Exchange Online  servers via EWS. To provide your Archive Manager server

with a MAPI subsystem, install Outlook with full Unicode compatibility. See System

Requirements for version compatibility with your Microsoft Exchange servers.

Steps to download the install media

1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. From your browser, navigate to the https://www.quest.com/products/archive-manager-for-

exchange page

or

navigate to the http://www.quest.com/trials page. Locate the product Archive Manager for

Exchange.

3. Click the Download Free Trial button.

4. Fill the Download Your Free Trial registration form and click Download Trial. The file download

page appears.

5. Download the install media zip file.

6. The the trial license key is specified in the email that is sent to you.

https://www.quest.com/products/archive-manager-for-exchange
https://www.quest.com/products/archive-manager-for-exchange
http://www.quest.com/trials
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7. Ensure that the files are available locally on the computer on which you are planning to install

the Archive Manager for Exchange features.

Install the Application Features

For HSM and Search server (AMXHSM)

The installations steps described in this topic includes the the installation of the Archive Manager

Post-processing feature.

Install HSM and Archive Manager Search

For Archive server (AMXSERVER-A)

The installations steps described in this topic includes the the installation of all sub-features.

Install the Archive server

For Retrieve server (AMXSERVER-R)

Install the Retrieve server

Install HSM and Archive Manager Search

In this topic:

· Worksheet for this installation

· Steps to install HSM and Archive Manager Search

· Steps to verify the installation

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

HSM server The server where the HSM and

Archive Manager Search will be

installed.

AMXHSM

Installer account Windows account that is used to

install the application. This is

username:

democorp\domadmin
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usually the enterprise

administrator.

password: **************

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************

Media Folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

HSM Store folder Full path of the folder that will

contain the archived files.

C:\HSM

The local hard drive folder is

used as the default media store.

Use of other media storage

systems are described in the

Media Store Administration

Guide.

Store name Name of the media store on a

hard drive. With the Advanced

Installation option of the

installer wizard, only a local hard

drive can be setup as a media

store.

FilesStore

Schema name Name of a schema in a hard

drive media store.

FilesSchema

Database Authentication

method

Type of database

authentication: Integrated

Windows Authentication or SQL

Authentication

Integrated Windows

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

AMXDB
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Archive Manager for Files will be

installed.

Steps to install HSM and Archive Manager Search
1. Log in to the server with the credentials of the enterprise administrator (eg.

democorp\domadmin).

2. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

3. If the installer does not start immediately, run the MAMInstaller.exe from your install media

folder. The Welcome window opens.

4. From the navigation panel on the left, click PLANNING. The Planning window opens. Review

the requirements and release notes. If necessary, visit the Quest website for more

information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window

opens. Read the Software Transaction Agreement. If you wish to proceed, select the I accept

the terms of the license agreement check box.

6. Click Next. The Installation Mode window opens. Select the Advanced installation option.
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7. Click Next. The Installation Components window opens. Select HSM and Archive Manager

Search.

8. Click Next. The Database Engine selection window opens. Select either Microsoft SQL Server

or Oracle.
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9. Click Next. The Checking Prerequisites window opens with database-specific prerequisites. If

one or more prerequisites are missing, the Next button is deactivated. Click Install to install

each prerequisite.

10. Click Next. The Superuser Account window opens. Specify the Super and Password. Enter the

password again in the Retype password field. 

If the superuser does not exist, the wizard will request permission to create the superuser

account in the Active Directory and grant the necessary permissions on this server to work

with the installed features. If the superuser exists, the dialog shown below does not appear.

If the permissions dialog appears, click Yes.
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11. Click Next. The Database Server Connection window opens. From the Component column,

select HSM.

NOTE: If you selected Oracle as your database engine, then the the Database Server

Connection window for Oracle opens.

Enter the database parameter values described below:

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Username - Username if SQL Authentication or Oracle client is selected. Otherwise this

field is deactivated.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise

this field is deactivated.

d. Schema name - Username of the installer account without the domain prefix. For example

dbo.

e. Server name - The name of the server where you are installing the HSM and Archive

Manager Search.

f. Database name - The name of the database that will contain the HSM metadata. The

default name is MAMHSM.
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For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

c. Username - database login username.

d. Password -  password of the database user.

12. From the Component column, select Archive Manager Search and verify the database

parameter values.

13. From the Component column, select Archive Manager Post-Processing and verify the database

parameter values.

NOTE: When you specify the HSM database parameter values, they are carried over to the

database specification for each feature in the list. While the features will be installed on

the same server, the database to host the metadata for each feature can be on a different

server and the database specifications section for each feature can be customized

accordingly.

14. Click Next. The Hierarchical Storage Manager Settings window opens.
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15. Specify the parameter values as described below:

a. Store name - Name of the media store. The default value is FilesStore.

b. Schema name - name of a schema in the media store. The default value is FilesSchema.

16. Click Next. The Please select the type of installation window opens.

Specify the parameter values as described below:

a. Search server - name of the server where the Archive Manager Search feature is installed.

For example AMXHSM.
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17. Click Next. The Firewall Settings window opens.

Select the Allow installation package to change the firewall settings check box. Archive

Manager for Exchange features will be then able to communicate through the firewall.

18. Click Next. The Summary Installation window opens. The installation summary displays

settings you have specified in previous steps.
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19. Click Install to start the installation.

20. The installer proceeds to install all the features. If a feature installation fails or completes

with a warning, expand the row to view and address the problem.

21. Click Finish to complete the installation step.

Steps to verify the installation
1. Open Start > Quest > Archive Manager Configuration. The Archive Manager Configuration

wizard opens.
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2. From the navigation panel, click HSM. The Configure HSM widow opens and the Database tab

is displayed by default.

Verify that the values are as expected.

3. Click the Stores tab to display information about the media store.

Verify that the values in the Stores and Schemas sections are as expected.
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4. From the navigation panel, click Search. The Configure Search window opens.

Verify that the values are as expected.

5. From the navigation panel, click Post-Processing. The Configure Search window opens.

Verify that the values are as expected.
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6. Close the Archive Manager Configuration wizard. If the Incomplete configuration dialog opens,

click Yes to dismiss the window and close the wizard.

7. Open Start > Windows Administrative Tools > Computer Management. The Computer

Management console opens.

8. From the Console Tree, expand Local Users and Groups.

9. Click the Groups node to display the list of groups.
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10. Right-click Administrators and select Properties from the context menu. The Administrators

Properties window opens.

Verify that the superuser account is listed in the Members panel. For example,

DEMOCORP\mamadmin

11. Click OK to close the properties window, and then close the Computer Management console.
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Install the Archive server

In this topic:

· Worksheet for this installation

· Steps to install Archive Manager for Exchange

· Steps to configure and verify the Archive server

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

License Key The license key that you

received from Quest. If you

don't have a license key, contact

your Quest representative.

894K5-3M448-M544E-A594A-

7K8Z7 (Sample only. This key is

neither an active nor an expired

license key)

Archive Manager for

Exchange server

The server where the Archive

Manager for Exchange will be

installed.

AMXSERVER-A

Installer account Windows account that is used to

install the application. This is

usually the enterprise

administrator.

username:

democorp\domadmin

password: **************

Superuser account Windows account that is used to

run the application and run the

Archive Manager for Exchange

services.

username:

democorp\mamadmin

password: **************

Media Folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

Database Authentication

method

Type of database

authentication: Integrated

Integrated Windows

Authentication
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Windows Authentication or SQL

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Exchange

will be installed.

AMXDB

HSM server The server where HSM is

installed.

AMXHSM

Search server The server where the Archive

Manager Search is installed.

AMXHSM

Steps to install Archive Manager for Exchange
1. Log in to the server with the credentials of the enterprise administrator (eg.

democorp\domadmin).

2. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

3. If the installer does not start immediately, run the MAMInstaller.exe from your install media

folder. The Welcome window opens.

4. From the navigation panel on the left, click PLANNING. The Planning window opens. Review

the requirements and release notes. If necessary, visit the Quest website for more

information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window

opens. Read the Software Transaction Agreement. If you wish to proceed, select the I accept

the terms of the license agreement check box.
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6. Click Next. The Installation Mode window opens. Select the Advanced installation option

7.  Click Next. The Installation Components window opens.

Select Archive Manager for Exchange.

NOTE: Archive Manager for Files could be installed on the same server. Installation of

Archive Manager for Files is described in the Quest® Archive Manager for Files Advanced

Installation Guide. ArchiveWeb is an enhancement. Installation of ArchiveWeb is

described in the Quest® Archive Manager for Exchange ArchiveWeb Guide.
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8. Click Next. The Database Engine selection window opens.

Select either Microsoft SQL Server (for on-premise MS SQL Database Server or Azure SQL

Database) or Oracle. 

9. Click Next. The Checking Prerequisites window opens.

If one or more prerequisites are missing, the Next button will appear deactivated. Click Install

for each prerequisite to install the missing features. Scroll down to expose and install all the

prerequisites.
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Scroll down to the bottom of the window. Click Validate your license. The Activate License Key

dialog opens.

If you are connected to the internet, select Online activation or see License Activation for

more options. Click Next. When your license is activated, you will see a confirmation message

and the license details. Click Finish to close the Activate License Key dialog.

10.  In the Checking Prerequisites window, click Next. The Superuser Account window opens.

Specify the Super and Password. Enter the password again in the Retype password field.
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11. Click Next. The Database Server Connection window opens.

NOTE: If you selected Oracle as your database engine, then the the Database Server

Connection window for Oracle opens.

Enter the database parameter values described below:

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Username - Username if SQL Authentication or Oracle client is selected. Otherwise this

field is deactivated.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise

this field is deactivated.

d. Schema name - Username of the installer account without the domain prefix. For example

dbo.

e. Server name - The name of the server where you are installing the HSM and Archive

Manager Search.

f. Database name - The name of the database that will contain the HSM metadata. The

default name is MAMHSM.

For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

c. Username - database login username.
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d. Password -  password of the database user.

12. Click Next. The Hierarchical Storage Manager Settings window opens.

In the HSM server name field enter the name of the server where the HSM application feature

is installed. For example AMXHSM.



42
Advanced Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

13. Click Next. The Please select the type of installation window opens.

In the Search server field enter the name of the server where the Archive Manager Search

feature is installed. For example AMXHSM.

14. Click Next. The Firewall Settings window opens.

Select the Allow programs to communicate through Windows Firewall check box. Archive

Manager for Exchange features will be then able to communicate through the firewall.
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15. Click Next. The Summary Installation window opens. The installation summary displays

settings you have specified in previous steps.

a. Select Manage the Organizational Forms Library if your organization uses this public folder

to share email templates. Otherwise, clear the check box.

b. Select the check box Start Archive Manager for Exchange to open the Archive Manager for

Exchange Administration Center (AMAC) when the installation completes.

16. Click Install to start the installation.  If a feature installation fails or completes with a warning,

expand the row to view and address the problem.
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17. Click Finish to complete the installation step.

18. The Archive Manager for Exchange Administration Center (AMAC) should open automatically

if the check box Start Archive Manager for Exchange was checked in the Summary Installation

step of the installation wizard. 

19. The Address Book Setup wizard opens automatically for a new installation. Click Close to exit

the wizard. Then close the Address Book Manager window that opens. For advanced

installation, Address Book setup can be done at a later step. For more information see Setup

the Address Book.
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Steps to configure and verify the Archive server
1. If the AMAC is not already open, click Start > Archive Manager for Exchange. The AMAC opens.

On the status bar at the bottom of the window, verify that the Server Role is set to Archive

Server.

2. Open Start > Quest > Archive Manager Configuration. The Archive Manager Configuration

wizard opens.

3. From the product panel, click Auditing. The Configure Auditing window opens and the

Database tab is displayed by default.
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Verify that the values are as expected.

4. From the product panel, click Users. The Configure Users window opens and the Database tab

is displayed by default.

Verify that the values are as expected.



47
Advanced Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

5. From the navigation panel, click Exchange Archive. The Configure Exchange Archive window

opens and the Database tab is displayed by default. Verify that the values are as expected.

6. Click the Settings tab and verify the settings as described below:

a. Archive server - name of the computer where Archive Manager for Exchange is installed.

b. HSM server -  name of the computer where HSM is installed.

7. Close the Archive Manager Configuration wizard.

8. Open Start > Windows Administrative Tools > Computer Management. The Computer

Management console opens.

9. From the Console Tree, expand Local Users and Groups.

10. Click the Groups node to display the list of groups.
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11. Right-click Administrators and select Properties from the context menu. The Administrators

Properties window opens.

Verify that the superuser account is listed in the Members panel. For example,

DEMOCORP\mamadmin

12. Click OK to close the properties window, and then close the Computer Management console.
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Install the Retrieve server

In this topic:

· Worksheet for this installation

· Steps to install Archive Manager for Exchange

· Steps to configure and verify the Retrieve server

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

License Key The license key that you

received from Quest. If you

don't have a license key, contact

your Quest representative.

894K5-3M448-M544E-A594A-

7K8Z7 (Sample only. This key is

neither an active nor an expired

license key)

Archive manager for

Exchange server

The server where the Archive

Manager for Exchange will be

installed with the Retrieve role.

AMXSERVER-R

Installer account Windows account that is used to

install the application. This is

usually the enterprise

administrator.

username:

democorp\domadmin

password: **************

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************

Media Folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

Database Authentication

method

Type of database

authentication: Integrated

Integrated Windows

Authentication
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Windows Authentication or SQL

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Files will be

installed.

AMXDB

HSM server The server where HSM is

installed.

AMXHSM

Search server The server where the Archive

Manager Search is installed.

AMXHSM

Steps to install Archive Manager for Exchange
1. Log in to the server with the credentials of the enterprise administrator (eg.

democorp\domadmin).

2. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

3. If the installer does not start immediately, run the MAMInstaller.exe from your install media

folder. The Welcome window opens.

4. From the navigation panel on the left, click PLANNING. The Planning window opens. Review

the requirements and release notes. If necessary, visit the Quest website for more

information.

5. From the navigation panel on the left, click INSTALLATION. The Server Installation window

opens. Read the Software Transaction Agreement. If you wish to proceed, select the I accept

the terms of the license agreement check box.
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6. Click Next. The Installation Mode window opens. Select the Advanced installation option

7.  Click Next. The Installation Components window opens.

Select Archive Manager for Exchange.
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8. Click Next. The Database Engine selection window opens.

Select either Microsoft SQL Server (for on-premise MS SQL Database Server or Azure SQL

Database) or Oracle. 

9. Click Next. The Checking Prerequisites window opens.

If one or more prerequisites are missing, the Next button will appear deactivated. Click Install

for each prerequisite to install the missing features. Scroll down to expose and install all the

prerequisites.
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Scroll down to the bottom of the window. Click Validate your license. The Activate License Key

dialog opens.

If you are connected to the internet, select Online activation or see License Activation for

more options. Click Next. When your license is activated, you will see a confirmation message

and the license details. Click Finish to close the Activate License Key dialog.

10.  In the Checking Prerequisites window, click Next. The Superuser Account window opens.

Specify the Super and Password. Enter the password again in the Retype password field.
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11. Click Next. The Database Server Connection window opens.

NOTE: If you selected Oracle as your database engine, then the the Database Server

Connection window for Oracle opens.

Enter the database parameter values described below;

For Microsoft SQL Server

a. Authentication - database authentication method.

b. Username - Username if SQL Authentication or Oracle client is selected. Otherwise this

field is deactivated.

c. Password - Database password if SQL Authentication or Oracle client is selected. Otherwise

this field is deactivated.

d. Schema name - Username of the installer account without the domain prefix. For example

dbo.

e. Server name - The name of the server where you are installing the HSM and Archive

Manager Search.

f. Database name - The name of the database that will contain the HSM metadata. The

default name is MAMHSM.

For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

c. Username - database login username.
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d. Password -  password of the database user.

12. Click Next. The Hierarchical Storage Manager Settings window opens.

Specify the parameter values as described below:

a. HSM server name - name of the server where the HSM and Archive manager Search

features are installed. For example AMXHSM.
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13. Click Next. The Please select the type of installation window opens.

Specify the parameter values as described below:

a. Search server - name of the server where the Archive Manager Search feature is installed.

For example AMXHSM.

14. Click Next. The Firewall Settings window opens.

Select the Allow installation package to change the firewall settings check box. Archive

Manager for Exchange features will be then able to communicate through the firewall.
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15. Click Next. The Summary Installation window opens. The installation summary displays

settings you have specified in previous steps.

a. Select Manage the Organizational Forms Library if your organization uses this public folder

to share email templates. Otherwise, clear the check box.

b. Select the check box Start Archive Manager for Exchange to open the Archive Manager for

Exchange Administration Center (AMAC) when the installation completes.

16. Click Install to start the installation. If a feature installation fails or completes with a warning,

expand the row to view and address the problem.
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17. Click Finish to complete the installation step.

18. The Archive Manager for Exchange Administration Center (AMAC) should open automatically

if the check box Start Archive Manager for Exchange was checked in the Summary Installation

step of the installation wizard.

19. The Address Book Setup wizard opens automatically for a new installation. Click Close to exit

the wizard. Then close the Address Book Manager window that opens.
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Steps to configure and verify the Retrieve server
1. If the AMAC is not already open, click Start > Archive Manager for Exchange. The AMAC opens.

2. From the Tools menu select Options. The Options window opens.

3. From the Select the server role drop down list, select Retrieve Server.

4. Click OK to set the server role and close the window.
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On the status bar at the bottom of the AMAC window, verify that the Server Role is set to

Retrieve Server.

5. Open Start > Quest > Archive Manager Configuration. The Archive Manager Configuration

wizard opens.

6. From the navigation panel, click Users. The Configure Users window opens and the Database

tab is displayed by default. Verify that the values are as expected.
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7. From the navigation panel, click Exchange Archive. The Configure Exchange Archive window

opens and the Database tab is displayed by default. Verify that the values are as expected.

8. Click the Settings tab and verify the settings as described below:

a. Archive server - name of the computer where Archive Manager for Exchange is installed.

b. HSM server -  name of the computer where HSM is installed.

9. Close the Archive Manager Configuration wizard.

10. Open Start > Windows Administrative Tools > Computer Management. The Computer

Management console opens.

11. From the Console Tree, expand Local Users and Groups.

12. Click the Groups node to display the list of groups.
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13. Right-click Administrators and select Properties from the context menu. The Administrators

Properties window opens.

Verify that the superuser account is listed in the Members panel. For example,

DEMOCORP\mamadmin

14. Click OK to close the properties window, and then close the Computer Management console.
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Manual Installation

6

Manual installation gives you a more granular control over the installation process. Manual

installation does not use the integrated installer wizard that was used to demonstrate Express

installation in the Quick Start Guide or the Advanced installation described in the Advanced

Installation chapter in this guide. This chapter describes in detail the manual steps required to

prepare the servers,  install the Archive Manager for Exchange features by using the individual

installers for each feature, and the manual steps to setup the databases and configure the

features to communicate with each other as described in the Deployment Plan.

In this chapter:

· Setup the Superuser Account

· Modify the Exchange server throttling policy

· Setup the Organizational Forms Library

· Prepare the Archive Manager for Exchange Servers

o Steps to download the install media

o Steps to install the prerequisites

o Steps to assign DCOM access and launch permissions

o Steps to install Microsoft Outlook

· Install Archive Manager for Exchange

o Install HSM

o Install Archive Manager Search

o Install the Archive server

o Install the Retrieve server

NOTE: The installation and configuration of optional features are described in detail in the

guides published for each feature.

For next steps after you complete the manual installation, see Application Configuration.
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Setup the Superuser Account
A superuser account is a windows account with administrator privileges to work with Archive

Manager for Exchange administration tools, run services, manage databases, manage extensions.

It also has elevated privileges to interact with the on-premise or online Microsoft Exchange

servers.

In this topic:

1. Steps to create the superuser account

2. Steps to grant the superuser read permission for the Container node in the domain controller

3. Steps to add the superuser to the Administrators group in feature servers

4. Steps to add the superuser as a database user with sysadmin role (for Windows authentication

only)

5. Steps to create a mailbox for the superuser in the Exchange server

6. Steps to grant the superuser elevated roles and permissions in the Exchange server

7. Steps to grant the superuser impersonation rights in the Exchange server (for OWA)

Steps to create a superuser account
1. Log in to the domain controller.

2. Navigate to Start > Windows Administrative Tools > Active Directory Users and Computers.

3. From the Console Tree, expand the domain node.

4. Click the Users container. The list of users opens in the right-hand pane.

5. Click the Action menu and select New > User. The New Object - User window opens.
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6. Verify that Create in title indicates the appropriate domain name and container, and then

enter the details of the superuser. For example:

a. Full name: MAM Administrator

b. User logon name: mamadmin@democorp.com

7. Click Next. 

8. Enter the password and confirm it. Then select Password never expires. Uncheck all other

check boxes.

9. Click Next.

10. Verify the information and click Finish.
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Steps to grant the superuser read permission for the
Container node in the domain controller
Microsoft Exchange servers and other information stores are created as child nodes under the

CN=Services,CN=Configuration,DC=<root domain> node in the domain controller. The superuser

needs sufficient permissions to read the list of Exchange servers and information stores of the

organization. A read permission must be granted to the superuser to be able to access the object

and all its descendant objects. 

1. Log in to the domain controller.

2. Navigate to Start > Windows Administrative Tools > ADSI Edit.

3. Click the Action menu, and then click Connect to. The Connection Settings window opens.

4. In the Connection Point frame, choose Select a well known Naming Context. From the drop

down list select Configuration.

5. Click OK. The Configuration context appears in the ADSI editor.

6. Expand or select the Configuration context to display the node (begins with

CN=Configuration).

7. Right-click the node and select Properties.

8. In the properties window, click the Security tab, and then click Add. 

9. In the Enter the object name to select field, enter the user logon name of the super user. For

example, enter democorp\mamadmin.

10. Click Check Names to verify the logon name.
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11. Click OK to add the superuser to the Administrator group.

12. Click Advanced. The Advanced Security Settings for Configuration window opens.

13. From the Permissions tab, select the superuser, and then click Edit. The Permission Entry for

Configuration window opens.

14. In the Applies To drop down select This object and all descendant objects.

15. Click OK, and then click OK in each parent window to close all the windows.

16. Close the ADSI editor.

Steps to add the superuser to the Administrators
group in feature servers
The superuser must be able to run windows services and accomplish tasks that require
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administrator privileges on the Archive Manager for Exchange feature servers. Follow the steps

described below to grant administrator privilege to the superuser on each feature server.

1. Log in to each server with its local administrator credentials.

2. Navigate to Start > Windows Administrative Tools > Computer Management 

3. From the Console Tree, navigate to the System Tools > Local Users and Groups > Groups

container.

4. From the list of groups in the right-hand pane, right-click Administrators and select Properties

from the context menu. The Administrators Properties window opens.

5. Click Add.

6. In the Enter the object name to select field, enter the user logon name of the super user. For

example, enter sales\mamadmin

7. Click Check Names to verify the logon name.

8. Click OK to add the superuser to the Administrator group.

9. In the Administrators Properties window, click Apply and OK to complete the process.

TIP: Log out of the server and log in again with the superuser's credentials to quickly verify

that the superuser can access the server.

Steps to add the superuser as a database user with
sysadmin role
If you plan to use Windows authentication with a Microsoft SQL Server database, follow the steps

described below:

1. Log in to the database server with your database administrator credentials.

2. Open the SQL Server Management Studio on your SQL server database server.

3. Log in to the server instance for Archive Manager for Exchange databases.
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4. Open the Security folder.

5. Right-click on the Logins folder and select  New Login. The Login - New user properties window

appears.

6. If you want to assign rights to a Windows account, select Windows authentication.

7. Provide the login name in the text box. You can use the Browse button to select an existing

account if you chose Windows authentication (eg. democorp\mamadmin)

8. In the user properties window, click Server Roles from the Select a page panel and select the

check box Sysadmin.

9. Click OK to create the account.

NOTE: Follow the above steps to add the installer account (eg. democorp\domadmin) with

the Sysadmin role.

Steps to create a mailbox for the superuser in the
Exchange server
1. Open the Exchange Administrative Center (EAC) with your exchange administrator credentials.

2. Navigate to recipients > mailboxes

3. Click + and select the User mailbox option from the menu. The new user mailbox page opens.

4. Select Existing user and then click Browse. The Select User - Entire Forest page opens.

5. If you don't see the superuser in the list, search for the name. Select the superuser and click

OK.
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6. Click Save. The superuser mailbox appears in the mailboxes list.
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Steps to grant the superuser elevated roles and
permissions in the Exchange server
Archive Manager for Exchange requires that the super-user be granted some administrative

permissions and access to the mailboxes which will be archived. The steps described below use

Powershell scripts to grant the roles and permissions to the superuser. To grant roles and

permissions to the superuser, follow the steps described below:

1. In Exchange Server, open the Exchange Management Shell.

2. Grant the roles and to ensures that the mailboxes and public folders can be accessed using the

required administrative privileges.

a. Grant the Organization Management role

Add-RoleGroupMember –Identity "Organization Management" -Member
"mamadmin@democorp.com"

b. Grant the View-Only Organization Management role.

Add-RoleGroupMember –Identity "View-Only Organization Management" -
Member "mamadmin@democorp.com"

c. Grant the Public Folder Management role.

Add-RoleGroupMember –Identity "Public Folder Management" -Member
"mamadmin@democorp.com"

d. Grant Receive-As permissions to all mailboxes

Get-MailboxDatabase | Add-ADPermission -User "mamadmin@democorp.com" -
AccessRights ExtendedRight –ExtendedRights Receive-As, ms-Exch-Store-
Admin -InheritanceType "All"

Steps to grant the superuser impersonation rights in
the Exchange server
This step is required if you plan to access archived emails through OWA. 

NOTE: To install and configure the OWA extension for Archive Manager for Exchange, you

must run the Archive Manager OWA Extension Setup on Exchange Server. For more

information see the OWA Installation Guide.

1. In Exchange Server, open the Exchange Management Shell.

2. Grant the Impersonation permission

New-ManagementRoleAssignment –Name "Impersonation-MAM4Exchange" –Role
"ApplicationImpersonation" –User "srv_exchange"
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Modify the Exchange server throttling policy
Exchange Server uses client throttling policies to track the bandwidth that each user consumes,

and restricts bandwidth limits as necessary. Archive Manager for Exchange needs more resources

than the allowed limit, so the throttling policy must be changed for the superuser.

To change the throttling policy in the Exchange server (for example, AMXEXCH), open the

Exchange Management Shell and run the following commands:

New-ThrottlingPolicy AMXEXCH

Set-ThrottlingPolicy AMXEXCH -EwsCutoffBalance Unlimited -EwsMaxBurst
Unlimited -EwsMaxConcurrency Unlimited -EwsMaxSubscriptions Unlimited -
EwsRechargeRate Unlimited -RcaMaxConcurrency Unlimited -RcaCutoffBalance
Unlimited -RcaMaxBurst Unlimited -RcaRechargeRate Unlimited -
CpaMaxConcurrency Unlimited -CpaCutoffBalance Unlimited -CpaMaxBurst
Unlimited -CpaRechargeRate Unlimited

Set-Mailbox "mamadmin@democorp.com" -ThrottlingPolicy AMXEXCH

Setup the Organizational Forms Library
Archive Manager for Exchange stores email templates in a system folder called the Organizational

Forms Library. The templates are used to display archived emails to end users. Before you can

create the Organizational Forms Library folder in your Exchange server, you must first create a

public folder mailbox. Public folder mailboxes contain the hierarchy information as well as the

content for public folders. The first public folder mailbox that you create in the organization is

the primary hierarchy mailbox, which automatically sets up two folders: the IPM_SUBTREE and

the NON_IPM_SUBTREE. An Organizational Forms Library is a system folder that is stored in the

public folder called the EFORMS REGISTRY which is a sub-folder of the NON_IPM_SUBTREE system

folder. There can be several forms libraries, one for each language.

In this topic:

· Steps to create a public folder mailbox

· Steps to create the public folder Organization Forms Library

· Steps to add the superuser as the owner of the Organizational Forms Library

· Verify that the superuser has access to the Organizational Forms Library

Steps to create a public folder mailbox
NOTE: This must be a primary hierarchy mailbox which is the first public folder mailbox in

the organization and hosts the primary hierarchy. The primary hierarchy is the only
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writable copy of the hierarchy. 

1. Open the Exchange Administrative Center (EAC) with your exchange administrator credentials.

2. Navigate to Public folders > Public folder mailboxes, and then click the new public folder

mailbox icon +

3. In the new public folder mailbox window that opens, enter the following information:

a. Name: Enter the name for the public folder mailbox. For example, enter PFMBX-

DEMOCORP

b. Organizational unit: Click Browse to select the location in the Active Directory where the

mailbox object is created. If you don't select an organizational unit, the public folder

mailbox will be created in the default container for mailboxes.

c. Mailbox database: Click Browse to select the mailbox database where the mailbox is

created. If you don't select a mailbox database, it will be automatically assigned.

4. Click Save.

5. Verify that the mailbox appears in the public folder mailbox list.

Steps to create the public folder Organization Forms
Library
1. In Exchange Server, open the Exchange Management Shell.

2. To create a new public folder in the NON_IPM_SUBTREE directory that's named Organizational

Forms Library, run the following command:
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New-PublicFolder -Path "\NON_IPM_SUBTREE\EFORMS REGISTRY" -Name
"Organizational Forms Library"

3. To set the locale ID on the folder that you created, run the following command:

Set-PublicFolder "\NON_IPM_SUBTREE\EFORMS REGISTRY\Organizational Forms
Library" -EformsLocaleID EN-US

4. To determine the correct locale ID to use, see Languagecode Field.

Steps to add the superuser as the owner of the
Organizational Forms Library
1. In Exchange Server, open the Exchange Management Shell.

2. To add the superuser as the owner of the Organizational Forms Library folder so that the

superuser ca publish or create forms in the library, run the following command: 

3. Add-PublicFolderClientPermission "\NON_IPM_SUBTREE\EFORMS

REGISTRY\Organizational Forms Library" -User mamadmin@democorp.com -

AccessRights Owner

NOTE: If you're not sure about the name of the Organizational forms library in your

company, the following command can be used. It will owner rights to the child objects

under EFORMS REGISTRY: 

Get-PublicFolder -Identity "\NON_IPM_SUBTREE\EFORMS REGISTRY" -

GetChildren | Add-PublicFolderClientPermission -User

mamadmin@democorp.com -AccessRights Owner

4. Wait some time for replication to occur until the super-user is assigned owner rights to the

Organizational Forms library.

Verify that the superuser has access to the
Organizational Forms Library
1. Open Outlook with the superuser account. 

2. Click Home / New Items / More Items / Choose Form.

3. In the Look in down-drop box verify that the Organizational Forms Library exists.

https://docs.microsoft.com/en-us/previous-versions/office/developer/exchange-server-2007/aa579489(v=exchg.80)?redirectedfrom=MSDN
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Prepare the Application Servers
In this topic:

For the Archive Manager Database server (AMXDB)

See the System Requirements and About User Accounts chapters for preparing database servers.

For the HSM and Search server (AMXHSM)

· Steps to download the install media

· Steps to install the prerequisites

For the Archive server (AMXSERVER-A)

· Steps to download the install media

· Steps to install the prerequisites

· Steps to assign DCOM access and launch permissions

· Steps to install Microsoft Outlook

For Retrieve server (AMXSERVER-R)

· Steps to download the install media

· Steps to install the prerequisites

· Steps to assign DCOM access and launch permissions

· Steps to install Microsoft Outlook

TIP: We recommend completing all these tasks using the installer account.

Steps to install the prerequisites

These steps are optional and are included if you want to install them yourself. The installer

verifies prerequisites.

1. Log in with the credentials of the local administrator.

2. Open PowerShell as an Administrator.

3. To install the recommended windows roles and features for individual components that may

be distributed across other servers run the following PowerShell commands:



76
Manual  Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

Archive Manager for Exchange (for Archive and Retrieve servers)

Install-WindowsFeature -Name Web-Server, Web-Http-Redirect,
Web-Dyn-Compression, Web-Windows-Auth, Web-Basic-Auth,
Web-Metabase, Web-Mgmt-Service, RSAT-AD-PowerShell,
NET-Framework-45-Features, NET-Framework-45-ASPNET,
Web-Net-Ext45, Web-Asp-Net45, NET-WCF-Services45, Web-Asp-Net

HSM

Install-WindowsFeature -Name Web-Server, NET-Framework-Features

Search

Install-WindowsFeature -Name NET-Framework-Features

ArchiveWeb

Install-WindowsFeature -Name NET-WCF-HTTP-Activation45, Web-Server,
Web-Static-Content, Web-Http-Redirect, Web-Stat-Compression,
Web-Dyn-Compression, Web-Windows-Auth, Web-Basic-Auth

NOTE: These PowerShell commands are compatible with a Window 2016 operating

system. Please refer to the System Requirements chapter to modify the script for other

supported Windows operating systems or install them manually.

4. Install the database drivers. For Microsoft SQL Server, the database driver is available in the

folder <installation folder>\Archive Manager Installation Package\Install.

5. Install the redistributable packages required for your operating system. These files are

available in the folder <installation folder>\Archive Manager Installation

Package\Install.

Steps to assign DCOM access and launch permissions

Grant Access Permissions to the Distributed COM Users group

1. Open Start > Windows Administrative Tools > Component Services.

2. From the Console Tree, go to Component Service > Computers > My Computer.

3. Right-click My Computer and select Properties from the context menu. The My Computer

Properties window opens.
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4. Open the COM Security tab and click Edit Default. The Access Permissions window open.

5. Click Add. The Select users or Groups window opens.

6. Click Locations and select the Archive Manager server (for example, AMXSERVER-A)

7. Search and add the following:

a. Distributed COM Users

b. NETWORK SERVICE

8. Select Distributed COM Users from the list.

9. In the Permissions for Distributed COM Users section, select Allow for both Local Access and

Remote Access.

10. Select NETWORK SERVICE from the list.

11. In the Permissions for Distributed COM Users section, select Allow for Local Access only.
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12. Click OK to close the Access Permissions window.

13. Keep the My Computer Properties window open and continue with the instructions below.
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Grant Launch and Activation Permissions to the Distributed COM Users
group

1. From the My Computer Properties window verify that the COM Security tab is opened.

2. Click Edit Default. The Access Permissions window open.

3. Click Add. The Select users or Groups window opens.

4. Click Locations and select the Archive Manager server (for example, AMXSERVER-A)

5. Search and add the following:

a. Distributed COM Users

b. NETWORK SERVICE

6. Select Distributed COM Users from the list.

7. In the Permissions for Distributed COM Users section, select Allow for Local Launch, Remote

Launch, Local Activation and Remote Activation.

8. Select NETWORK SERVICE from the list.

9. In the Permissions for Distributed COM Users section, select Allow for Local Launch and Local

Activation only.
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10. Click OK to close the Access Permissions window.

11. Close the Component Services console.

Steps to install Microsoft Outlook

The Archive Manager Server communicates with Microsoft Exchange on-premise servers via MAPI

or EWS and Microsoft Exchange Online  servers via EWS. To provide your Archive Manager server

with a MAPI subsystem, install Outlook with full Unicode compatibility. See System

Requirements for version compatibility with your Microsoft Exchange servers.

Steps to download the install media

1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. From your browser, navigate to the https://www.quest.com/products/archive-manager-for-

exchange page

or

navigate to the http://www.quest.com/trials page. Locate the product Archive Manager for

Exchange.

3. Click the Download Free Trial button.

4. Fill the Download Your Free Trial registration form and click Download Trial. The file download

page appears.

5. Download the install media zip file.

6. The the trial license key is specified in the email that is sent to you.

https://www.quest.com/products/archive-manager-for-exchange
https://www.quest.com/products/archive-manager-for-exchange
http://www.quest.com/trials
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7. Ensure that the files are available locally on the computer on which you are planning to install

the Archive Manager for Exchange features.

Install the Application Features
This topic describes the manual installation steps for each feature and feature that comprises a

single-server installation.

In this topic:

· Install HSM

· Install Archive Manager Search (with Post-processing)

· Install the Archive server

· Install the Retrieve server

Install HSM

In this topic:

· Worksheet for this installation

· Steps to install HSM

· Steps to configure the HSM database connection

· Steps to install the HSM database

· Steps to configure the HSM stores and schemas

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

HSM server The server where the HSM and

Archive Manager Search will be

installed.

AMXHSM

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************
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Media folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

HSM Store folder Full path of the folder that will

contain the archived files.

C:\HSM

The local hard drive folder is

used as the default media store.

Use of other media storage

systems are described in the

Media Store Administration

Guide.

Store name Name of the media store on a

hard drive. With the Advanced

Installation option of the

installer wizard, only a local hard

drive can be setup as a media

store.

FILESTORE

Schema name Name of a schema in a hard

drive media store.

FILESCHEMA

Database Authentication

method

Type of database

authentication: Integrated

Windows Authentication or SQL

Authentication

Integrated Windows

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Files will be

installed.

AMXDB

Steps to install the application

1. Log in to the server (eg. AMXHSM) with the credentials of the superuser (eg.

democorp\mamadmin)
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2. Download the installation media. For more information see Steps to download the install

media.

3. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

4. Close the integrated installer wizard which starts automatically.

5. Run the HSM setup from <Media folder>\Archive Manager Installation
Package\HSM\HSM Setup.exe

6. A prerequisite check occurs and missing requirements if any are displayed. Click Install to

ensure all missing requirements are installed.

7. The Welcome window of the HSM installer opens.

8. Click Next. The Logon Information window opens.

Enter the information as described below:
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a. Username - logon name of the superuser (for example, democorp\mamadmin)

b. Password - logon password of the superuser

c. Confirm password - same as the Password.

9. Click Next. The Firewall Settings window opens.

Select Allow programs to communicate through Windows Firewall. 

10. Click Next. The Ready to install the Program window opens.

11. Click Install. The installation starts and the progress is displayed on the Setup Status window.

When the installation completes, the InstallShield Wizard Complete window opens.
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12. Click Finish to close the installer. 

Steps to configure the HSM database connection

1. When the installation completes, the Archive Manager Configuration wizard opens. If it does

not open automatically, click Start > Quest > Archive Manager Configuration.

2. From the feature panel on the left, click HSM and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4. Select either Microsoft SQL Server or Oracle and click Next. If you choose Microsost SQL

Server, the Database Connection window opens for the Microsoft SQL Server connection

information.
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For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMHSM which is the default name of the

HSM database)

c. Schema name - name of the SQL Schema (e.g. dbo)

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file.

b. Schema - name of the Oracle schema from your tnsnames.ora file.

c. Username - database login username.

d. Password -  password of the database user.

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration completion window opens.
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7. Click Finish to close the Database Connection wizard.

Steps to install the HSM database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click HSM

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

script installer wizard opens.

3. Select Use the default credentials to use the information displayed in the Database

connections section. If you select Use different credentials, enter the following information:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

a. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.
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b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

4. Click Next. 

In the Select the method for setting up the database step, choose one of the following

options:

a. Run the database scripts by this wizard - the installer will automatically run the scripts to

create the tables and procedures required for the database.

b. Get the database scripts and run them manually - you get the option to either save the

scripts or copy it to clipboard and paste it elsewhere.

5. Click Next. Depending on your selection, one of the following windows open:

For Run the database scripts by this wizard

Select both check boxes: Create tables and Create procedures.

For Get the database scripts and run them manually
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You must run both the scripts for a successful database installation.

6. Click Next. Depending on your selection in step 4, one of the following windows open

a. If you chose Run the database scripts by this wizard, and the installation is successful, a

confirmation dialog opens. Click OK to close the dialog.

b. If you chose Get the database scripts and run them manually, you must run the scripts

immediately because a confirmation dialog will verify whether you ran the scripts.

Select both check boxes after you run scripts and click OK.

7. If the installation is successful, the confirmation dialog opens. Click OK to close the dialog. The

database setup completion window opens.
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8. Click Finish to close the script installer. The Scripts section of the Archive Manager

Configuration wizard displays the status and version of the scripts(the version of the scripts

you install may differ from the version shown in the image below).

9. Keep the Archive Manager Configuration wizard open for next steps.

Steps to configure the HSM stores and schemas

1. From the feature panel on the left of the Archive Manager Configuration wizard, click HSM

and select the Stores tab.

2. From the Stores section click New Store. The Create a new media Store window opens.



91
Manual  Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

3. Click Next. The location information window opens.

Enter the information as described below;

a. Storage Provider - select Hardisk, UNC Path because we are going to setup a media store in

folder on the local hard drive.

b. Path for the media store - Browse and create the folder if it does not exist (eg. C:\HSM).

You could specify a UNC path to a shared folder as well.

4. Keep clicking Next to accept the default settings on each window until you reach the HSM

server connection information window. Every media store must provide this information so

the HSM server can connect to it. For more information about various media stores see the

Archive Manager for Exchange - Media Store Administration Guide.
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5. Click Add. The Add Server window opens. Enter the following information:

a. Server type - select HSM Server

b. Server name - name of the server where HSM is installed (eg. AMXHSM)

6. Click OK to close the window and add the the HSM Server to the list.

7. Click Next. The final configuration window appears.

8. Accept the defaults and click Finish. The Service Restart window opens.
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Select one or more check boxes where the Status indicates Stopped. Click Yes to restart the

service so that the HSM service is aware of the media store configuration.

9. Verify that the media store information appears in the Stores tab of the Archive Manager

Configuration wizard.

10. From the Schemas section in the Stores tab of the the Archive Manager Configuration wizard,

click New Schema. The Create new schema window opens.

Enter the following information:

a.  Store field - verify that it indicates the media store you just created.

b. Schema name - enter a name for the schema (eg. FILESCHEMA)

11. Click OK to save the schema information. In the Service Restart window opens, select one or

more check boxes where the Status indicates Stopped. Click Yes to restart the service so that

the HSM service is aware of the schema information.
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12. Verify that the schema information appears in the Schemas section of the Stores tab in the

Archive Manager Configuration wizard.

13. Close the Archive Manager Configuration wizard.

NOTE: The steps to create a local media store described above with default values

completes the HSM installation. HSM offers more capabilities that can be configured.

Configuration of HSM is described in detail in the HSM Installation and Configuration

Guide. A large selection of media store types that are supported by Archive Manager for

Exchange are described in the Media Store Administration Guide.

Steps to test the HSM and Media Store connectivity

1. Open the Archive Manager Configuration wizard and select HSM from the feature panel. 

2. Click the Stores tab. Then click Test from the Schemas section. The HSM Test window opens.

3. Click Archive. The Archive window opens.
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Keep the default test file settings. Copy the value in the Unique content field if you wish to

test the retrieve process.

4. Click Archive. The Result window opens.

5. Verify that the result indicates success. Then click OK to close the Result window. Then close

the Archive window.

6. In the HSM Test window, enter the name of the file that was archived in the Media Store

during the archive test. 
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For example if the TestFile.txt was archived as 00000001.txt, enter 00000001 in the File

Identifier field.

7. Click Retrieve. The Result window opens.

8. Verify that the result indicates success. Then click OK to close the Result window. Then close

the other windows.

Install Search

The Archive Manager Search installer also installs the Post Processing service which allows a user

to run specific tasks on each archived message. Archive Manager Search can be installed on a

dedicated server, but in keeping with the topology described in the Deployment Plan we will

install the Archive Manager Search and Post Processing service on the same server where HSM

was installed (eg. AMXHSM).

In this topic:

For Archive manager Search

· Worksheet for this installation

· Steps to install Archive Manager Search (with Post Processing)

· Steps to configure the Search database connection

· Steps to install the Search database

· Steps to configure Search Scopes

For Post Processing

· Steps to configure the Post Processing database connection
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· Steps to install the Post Processing database

· Steps to configure Post Processing Scopes

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

HSM server The server where the HSM and

Archive Manager Search will be

installed.

AMXHSM

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************

Media folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

HSM Store folder Full path of the folder that will

contain the archived files.

C:\HSM

The local hard drive folder is

used as the default media store.

Use of other media storage

systems are described in the

Media Store Administration

Guide.

Store name Name of the media store on a

hard drive. With the Advanced

Installation option of the

installer wizard, only a local hard

drive can be setup as a media

store.

FILESTORE

Schema name Name of a schema in a hard

drive media store.

FILESCHEMA
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Database Authentication

method

Type of database

authentication: Integrated

Windows Authentication or SQL

Authentication

Integrated Windows

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Files will be

installed.

AMXDB

Steps to install Archive Manager Search

1. Log in to the server where HSM was installed (eg. AMXHSM) with the credentials of the

superuser (eg. democorp\mamadmin)

2. Download the installation media. For more information see Steps to download the install

media.

3. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

4. Close the integrated installer wizard which starts automatically.

5. Run the Archive Manager Search setup from <Media folder>\Archive Manager
Installation Package\Archive Manager Search\Archive Manager Search

Setup.exe

6. A prerequisite check occurs and missing requirements if any are displayed. Click Install to

ensure all missing requirements are installed.

7. The Welcome window of the HSM installer opens.
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8. Click Next. The License Agreement window opens.

9. Click Yes to accept the license. The Setup Type window opens. Click Print if you wish to print

the license agreement.

Select Complete to include Post Processing service. If you select Custom, you can modify the

installation folder path which defaults to C:\Program Files (x86)\Quest\MAMSearch, and

choose to whether you want to install Archive Manager Search or Post Processing or both.

10. Click Next. The Choose Destination Location windows opens. This setting is for the Archive

Manager for Files product and is not used by Archive Manager for Exchange.
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11. Accept the default setting and click Next. The Choose Destination Location for the mail index

opens.

12. Accept the default setting and click Next. The Logon Information window opens.

Enter the information as described below:

a. Username - logon name of the superuser (for example, democorp\mamadmin)

b. Password - logon password of the superuser

c. Confirm password - same as the Password.

13. Click Next. The Firewall Settings window appears.
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Select the check box Allow programs to communicate through Windows Firewall.

14. Click Next. The Ready to Install the Program window opens.

15. Click Install. The InstallShield Wizard Complete window opens.

Steps to configure the Search database connection

1. When the installation completes, the Archive Manager Configuration wizard opens. If it does

not open automatically, click Start > Quest > Archive Manager Configuration.
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2. From the feature panel on the left, click Search and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMSEARCH which is the default name of

the Archive Manager Search database)

c. Schema name - name of the SQL Schema (e.g. dbo)

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the HSM

database in your tnsnames.ora file (eg. AMXDB).
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b. Schema - name of the HSM database (e.g. MAMSEARCH which is the default name of the

Archive Manager Search database).

c. Username - database login username.

d. Password -  password of the database user.

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration confirmation window

opens.

7. Click Finish to close the Database Connection wizard.

Steps to install the Search database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Search

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.
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3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

a. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

c. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

5. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens
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Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

6. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

7. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts.
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Steps to configure Search Scopes

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Search

and select the Search Scopes tab.

2. Click Add. The Add Search scope window opens.

Enter the information and described below:

a. Server name - name of the primary Archive Manager for Exchange server (eg. AMXSERVER-

A) where the role will be set to Archive server.

b. Type - Select Exchange Archive Server.

3. Click Next. The Connection window for the Archive database opens.

4. If the MAMEXCH database already exists, click Import.

-or-

If the MAMEXCH database does not exist, follow the steps below to configure the database:
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a. Click Configure to setup the Archive Manager for Exchange database. The Database

Connection Wizard opens.

b. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.

For Microsoft SQL Server

· Server name - name of the SQL server (eg. AMXDB)

· Initial catalog - name of the Archive Manager for Files database (e.g. MAMEXCH which is

the default name of the Archive Manager for Files database)

· Schema name - name of the SQL Schema (e.g. dbo)

· Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

· Username - database login username if SQL Server authentication is the selected as the

authentication mode.
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· Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

· Oracle net name - net service name that describes the network address of the HSM

database in your tnsnames.ora file (eg. AMXDB).

· Schema - name of the Archive Manager for Files database (e.g. MAMEXCH which is the

default name of the Archive Manager for Files database).

· Username - database login username.

· Password -  password of the database user.

c. Click Next and then click Yes on the confirmation dialog that opens.

d. If the database connection is setup successfully, the configuration confirmation window

opens.

e. Click Finish to close the Database Connection wizard. 

5. The Configuration window for the Archive database reopens.
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6. Click Next. The Configuration window for the Index database opens.

7. If the MAMINDEX database already exists, click Import. 

-or-

If the MAMINDEX database does not exist, follow the steps below to configure the database:

a. Click Configure to setup the Archive database connection. The Database Connection

Wizard opens.

b. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.
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For Microsoft SQL Server

· Server name - name of the SQL server (eg. AMXDB)

· Initial catalog - name of the Archive Manager for Files database (e.g. MAMINDEX which is

the default name of the Archive Manager for Files database)

· Schema name - name of the SQL Schema (e.g. dbo)

· Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

· Username - database login username if SQL Server authentication is the selected as the

authentication mode.

· Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

· Oracle net name - net service name that describes the network address of the HSM

database in your tnsnames.ora file (eg. AMXDB)

· Schema - name of the Archive Manager for Files database (e.g. MAMINDEX which is the

default name of the Archive Manager for Files database)

· Username - database login username.

· Password -  password of the database user

c. Click Next and then click Yes on the confirmation dialog that opens.
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d. If the database connection is setup successfully, the configuration confirmation window

opens.

e. Click Finish to close the Database Connection wizard. 

8. The Configuration window for the Index database reopens.

9. Click Next. The Index directory window opens.
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10. Click Browse to select or create a folder for the search index and then click Next. The Apply the

configuration changes confirmation window opens.

11. Click Finish. The Archive server is added to the Manage search scopes section.

12. If the Restart service window opens, click Yes to restart the MAM service. Otherwise you must

start the windows service manually.

13. Close the Archive Manager Configuration wizard.
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Steps to configure the Post Processing database connection

1. When the installation completes, the Archive Manager Configuration wizard opens. If it does

not open automatically, click Start > Quest > Archive Manager Configuration.

2. From the feature panel on the left, click Post Processing and select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4. Click Next. The SQL Server connection window opens.

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the confirmation window opens.
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7. Click Finish to close the Database Connection wizard.

Steps to install the Post Processing database

1. From the feature panel on the left of the Archive Manager Configuration wizard, click Post

Processing and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.

Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

3. Click Next. The run Scripts authentication window opens.
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Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

b. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

c. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

d. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

4. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

5. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.
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6. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section displays the status and version of the scripts (the version of

the scripts you install may differ from the version shown in the image below).

IMPORTANT: You may close the Archive Manager Configuration wizard. Click Cancel on any

warning dialogs that may open. Additional Post Processing configuration is required but

must wait until the Archive Server installation and configuration is completed. See Install

the Archive server for next steps.

Steps to configure Post Processing Scopes

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Post

Processing and select the Post Processing Scopes tab.
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Enter the information and described below:

a. Server name - specify the name of the Archive Manager for Exchange server which will be

the designated Archive server. For example, AMXSERVER-A

b. Type - select Archive server for Exchange

2. Click OK. If you have did not install the Archive server for Exchange yet, an error message

appears

3. Click OK. The Configuration window for the Post Processing Scopes opens.

Enter the following information:

a. Activated - select the check box to activate the Post Processing Scope for Exchange.

b. HSM server - name of the HSM server

c. Index directory - full path to the index directory, the default path is C:\Program Files (x86)

\Quest\MAMSearch\Index\Mail

d. Mailboxes index - number of mailboxes that can be indexed.

e. Exchange database - click Configure and use the wizard to connect to the Archive Manager

database.

f. Plugins - click Add to insert the plugins.
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4. Click OK to add the Post processing scope for Archive Manager for Exchange.

Install the Archive server

In this topic:

· Worksheet for this installation

· Steps to install Archive Manager for Exchange

· Steps to configure the Archive Manager database connection
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· Steps to install the Archive Manager database

· Steps to configure the Auditing database

· Steps to install the Auditing database

· Steps to configure the User database

· Steps to install the User database

· Steps to start the Archive Manager services

· Steps to configure and verify the Archive server
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Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

License Key The license key that you

received from Quest. If you

don't have a license key, contact

your Quest representative.

894K5-3M448-M544E-A594A-

7K8Z7 (Sample only. This key is

neither an active nor an expired

license key)

Archive manager for

Exchange server

The server where the Archive

Manager for Exchange will be

installed.

AMXSERVER-A

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************

Media folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest

Database Authentication

method

Type of database

authentication: Integrated

Windows Authentication or SQL

Authentication

Integrated Windows

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Files will be

installed.

AMXDB
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HSM server The server where HSM is

installed.

AMXHSM

Search server The server where the Archive

Manager Search is installed.

AMXHSM

Steps to install Archive Manager for Exchange
1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

3. Close the integrated installer wizard if it starts automatically.

4. Run the Archive Manager setup. The default path is C:\Quest\Archive Manager

Installation Package\Exchange\Archive Manager for Exchange Setup.exe 

5. A prerequisite check occurs and missing requirements if any are displayed. Click Install to

ensure all missing requirements are installed.

6. The Welcome window of the Archive Manager for Exchange installer opens.

7. Click Next. The License Agreement window opens.
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8. Click Yes to accept the license. The License Key window opens. Click Print if you wish to print

the license agreement.

9. If you are connected to the internet, select Online activation or see License Activation for

more options. Click Next. When your license is activated, you will see a confirmation message

and the license details. Click Finish to close the Activate License Key dialog.
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10. Click Change to choose another installation folder or keep the default and click Next. The

Select Features window opens.

Mandatory features

· Application Server

· Administrative tool

Optional features

· Auditing

· Monitoring service

Optional resources
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· PST Importer. For more information see the Quest® Archive Manager for Exchange PST

Importer Guide.

· Forms Installer

· Documentation

11. Click Next. The Archive Manager site port Information window opens.

12. Keep the default port 80 unless there are other application co-located on this server that also

use port 80. Click Next and the Select HSM server window opens.

In the HSM server field, enter the name, FQDN or IP address of the server where the HSM

application feature was installed. You can click Browse to locate the server in the domain.

13. Click Test server to verify the connection and then click Next. The Search server window

opens.
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Check the Activate Archive Manager Search to allow search functionality from this server. In

the Search server field, enter the name, FQDN or IP address of the server where the HSM

application feature was installed. You can click Browse to locate the server in the domain.

14. Click Next. The Logon Information window opens.

In the  field, specify the super (eg. democorp\mamadmin)and Password. Enter the password

again in the Confirm password field.

15. Click Next. The Firewall Settings window opens.
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Select the Allow programs to communicate through Windows Firewall check box. Archive

Manager for Exchange features will be then able to communicate through the firewall.

16. Click Next. The Ready to Install the Program window opens.

17. Click Install to start the installation. When the installation completes, the InstallShield Wizard

Complete window opens.
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18. Select the Launch Post Installation Tasks check box and click Finish. The Post installation Tasks

wizard opens.

Steps to configure the Archive Manager database connection

1. When the installation completes, the Post installation Tasks wizard opens. You can open the

the Post installation Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to the Archive Manager Configuration step to open the Archive Manager

Configuration wizard. To directly open the Archive Manager Configuration wizard click Start >

Quest > Archive Manager Configuration.

3. From the feature panel on the left, click Archive Manager and select the Database tab.

4. Click Configure. The Database Connection Wizard opens.
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5. Select either Microsoft SQL Server (for on-premise MS SQL Database Server or Azure SQL

Database) or Oracle and click Next. The database connection information window opens for

the selected database.

For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB).

b. Initial catalog - name of the HSM database (e.g. MAMEXCH which is the default name of

the Archive Manager for Exchange database).

c. Schema name - name of the SQL Schema (e.g. dbo).

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.
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For Oracle

a. Oracle net name - net service name that describes the network address of the HSM

database in your tnsnames.ora file (eg. AMXDB).

b. Schema - name of the HSM database (e.g. MAMEXCH which is the default name of the

Archive Manager for Exchange database).

c. Username - database login username.

d. Password -  password of the database user.

6. Click Next and then click Yes on the confirmation dialog that opens.

7. If the database connection is setup successfully, the confirmation window opens.

8. Click Finish to close the Database Connection wizard.

Steps to install the Archive Manager database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click

Exchange Archive and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.
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3. Click Select All to select all check boxes. Then click Next. The Run Scripts authentication

window opens.

Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

a. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

c. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

4. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens
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Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

5. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

6. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts (the version of the scripts you install may differ from the

version shown in the image below).
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7. Click the Settings tab and verify the settings as described below:

a. Archive server - name of the computer where Archive Manager for Exchange is installed.

b. HSM server -  name of the computer where HSM is installed.

8. Close the Archive Manager Configuration wizard.

Steps to configure the Auditing database

1. Open the Archive Manager Configuration wizard if it is not already open.

2. From the feature panel on the left, click Auditing and then select the Database tab.

3. Click Configure. The Database Connection Wizard opens.
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4. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.

For SQL Server

a. Server name - name of the SQL server (eg. AMXDB).

b. Initial catalog - name of the HSM database (e.g. MAMAUDIT which is the default name of

the Archive Manager for Exchange database).

c. Schema name - name of the SQL schema (e.g. dbo).

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

e. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file (eg. AMXDB).

f. Schema - name of the Auditing schema (e.g. MAMAUDIT which is the default name of the

Archive Manager for Exchange database).

g. Username - database login username.

h. Password -  password of the database user

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration confirmation window

opens.

7. Click Finish to close the Database Connection wizard.
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Steps to install the Auditing database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Auditing

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

5. Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

b. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

c. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

6. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

7. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens

8. Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

9. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

10. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts.
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11. Close the Archive Manager Configuration wizard.

Steps to configure the User database

1. Open the Archive Manager Configuration wizard if it is not already open.

2. From the feature panel on the left, click Users and then select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.

For SQL Server

a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMUSER which is the default name of

the Archive Manager for Exchange database)

c. Schema name - name of the SQL schema (e.g. dbo)

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file (eg. AMXDB).

b. Schema - name of the Auditing schema (e.g. MAMUSER which is the default name of the

Archive Manager for Exchange database).
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c. Username - database login username.

d. Password -  password of the database user.

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration confirmation window

opens.

7. Click Finish to close the Database Connection wizard.

Steps to install the User database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Users

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

5. Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

b. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

c. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

d. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

6. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens

7. Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

8. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

9. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts.
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10. Close the Archive Manager Configuration wizard.

Steps to start the Archive Manager for Exchange services

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 3 to start the services. 

NOTE: To start or stop the services at any time you can use the Start Stop Archive

Manager Services tool. For more information, see Starting and Stopping Services.

Steps to configure and verify the Archive Server
Unless you manually change the role, every installation of the Archive Manager for Exchange will

automatically assign the Archive Server role to the installed instance. The Archive Server role

indicates that this is the primary server and all administration tasks are controlled from this

server.

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 4 of the the Post installation Tasks wizard to open the AMAC. You can

also open the Archive Manager for Exchange Administration Center (AMAC) from Start >

Archive Manager for Exchange. The AMAC opens.



138
Manual  Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

3. On  the status bar at the bottom of the window, verify that the Server Role is set to Archive

Server.

4. The Address Book Setup wizard opens automatically for a new installation. Click Close to exit

the wizard. Then close the Address Book Manager window that opens. For a manual

installation, Address Book setup can be done at a later step. For more information see Setup

the Address Book.

NOTE: Whenever an Archive Manager for Exchange server is installed, the default role

assigned is Archive Server. These servers are also identified with a MultiServerID and a

LocationID which are integers that default to 1. Large organizations with more than 3000

mailboxes use more that one Archive server. Since the MultiServerID and LocationID of

each Archive server must be unique, you must manually change the MultiServerID and

LocationID of each extra Archive server by changing the following registry key values. For

example, for a second Archive server, set the following registry key values to 2, for a third

Archive server set the registry key values to 3, and so on.

HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Quest > exchangePAM >
MultiServerID
HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > Quest > exchangePAM >
OfflineStorage > LocationID
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Install the Retrieve server

In this topic:

· Worksheet for this installation

· Steps to install Archive Manager for Exchange

· Steps to configure the Archive Manager database

· Steps to install the Archive Manager database

· Steps to configure the User database

· Steps to install the User database

· Steps to start the Archive Manager services

· Steps to set the Retrieve Server role

· Steps to verify the Retrieve Server role

Worksheet for this installation
The following information will be required through the installation process. Sample values are

provided here as a guidance.

Item Description Example

License Key The license key that you

received from Quest. If you

don't have a license key, contact

your Quest representative.

894K5-3M448-M544E-A594A-

7K8Z7 (Sample only. This key is

neither an active nor an expired

license key)

Archive manager for

Exchange server

The server where the Archive

Manager for Exchange will be

installed.

AMXSERVER-R

Superuser account Windows account that is used to

install the application and run

the Archive Manager for

Exchange services.

username:

democorp\mamadmin

password: **************

Media folder Full path of the folder where the

media files are extracted

C:\Quest

Installation folder Full path of the folder where the

application files will be installed

C:\Program Files (x86)\Quest
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Database Authentication

method

Type of database

authentication: Integrated

Windows Authentication or SQL

Authentication

Integrated Windows

Authentication

Username Username if SQL Authentication

is selected

dbadmin

Password Database password if SQL

Authentication is selected

**************

Database server The database server instance

name where the databases for

Archive Manager for Files will be

installed.

AMXDB

HSM server The server where HSM is

installed.

AMXHSM

Search server The server where the Archive

Manager Search is installed.

AMXHSM

Steps to install Archive Manager for Exchange
1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin).

2. Run the Quest Archive Manager Installation Package to extract the files to a local folder.

3. Close the integrated installer wizard which starts automatically.

4. Run the Archive Manager Search setup from <Media folder>\C:\Quest\Archive
Manager Installation Package\Exchange\Archive Manager for Exchange

Setup.exe.

5. A prerequisite check occurs and missing requirements if any are displayed. Click Install to

ensure all missing requirements are installed.

6. The Welcome window of the Archive Manager for Exchange installer opens.



141
Manual  Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

7. Click Next. The License Agreement window opens.

8. Click Yes to accept the license. The License Key window opens. Click Print if you wish to print

the license agreement.
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9. If you are connected to the internet, select Online activation or see License Activation for

more options. Click Next. When your license is activated, you will see a confirmation message

and the license details. Click Finish to close the Activate License Key dialog.

10. Click Change to choose another installation folder or keep the default and click Next. The

Select Features window opens.
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Keep on the mandatory features. Uncheck all other check boxes.

· Application Server

· Administrative tool

11. Click Next. The Archive Manager site port Information window opens.

12. Keep the default port 80 unless there are other application co-located on this server that also

use port 80. Click Next and the Select HSM server window opens.
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In the HSM server field, enter the name, FQDN or IP address of the server where the HSM

application feature was installed. You can click Browse to locate the server in the domain.

13. Click Test server to verify the connection and then click Next. The Search server window

opens.

Check the Activate Archive Manager Search to allow search functionality from this server. In

the Search server field, enter the name, FQDN or IP address of the server where the HSM

application feature was installed. You can click Browse to locate the server in the domain.

14. Click Next. The Logon Information window opens.
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In the  field, specify the super (eg. democorp\mamadmin)and Password. Enter the password

again in the Confirm password field.

15. Click Next. The Firewall Settings window opens.

Select the Allow programs to communicate through Windows Firewall check box. Archive

Manager for Exchange features will be then able to communicate through the firewall.

16. Click Next. The Ready to Install the Program window opens.



146
Manual  Insta l lation

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

17. Click Install to start the installation. When the installation completes, the InstallShield Wizard

Complete window opens.

18. Select the Launch Post Installation Tasks check box and click Finish. The Post installation Tasks

wizard opens.
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Steps to configure the Archive Manager database

1. When the installation completes, the Post installation Tasks wizard opens. You can open the

the Post installation Tasks wizard from C:\Program Files (x86)
\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to the Archive Manager Configuration step to open the Archive Manager

Configuration wizard. To directly open the Archive Manager Configuration wizard click Start >

Quest > Archive Manager Configuration.

3. From the feature panel on the left, click Archive Manager and select the Database tab.

4. Click Configure. The Database Connection Wizard opens.

5. Select either Microsoft SQL Server (for on-premise MS SQL Database Server or Azure SQL

Database) or Oracle and click Next. The database connection information window opens for

the selected database.
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For Microsoft SQL Server

a. Server name - name of the SQL server (eg. AMXDB).

b. Initial catalog - name of the HSM database (e.g. MAMEXCH which is the default name of

the Archive Manager for Exchange database).

c. Schema name - name of the SQL Schema (e.g. dbo).

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the HSM

database in your tnsnames.ora file (eg. AMXDB).

b. Schema - name of the HSM database (e.g. MAMEXCH which is the default name of the

Archive Manager for Exchange database).

c. Username - database login username.

d. Password -  password of the database user.

6. Click Next and then click Yes on the confirmation dialog that opens.

7. If the database connection is setup successfully, the confirmation window opens.
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8. Click Finish to close the Database Connection wizard.

Steps to install the Archive Manager database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Search

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.
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Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication.

a. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.

b. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

c. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

5. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens

Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

6. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.
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7. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts (the version of the scripts you install may differ from the

version shown in the image below).

8. Click the Settings tab and verify the settings as described below:
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a. Archive server - name of the computer where Archive Manager for Exchange is installed.

b. HSM server -  name of the computer where HSM is installed.

9. Close the Archive Manager Configuration wizard.

Steps to configure the User database

1. Open the Archive Manager Configuration wizard if it is not already open.

2. From the feature panel on the left, click Users and then select the Database tab.

3. Click Configure. The Database Connection Wizard opens.

4. Select either Microsoft SQL Server or Oracle and click Next. The database connection

information window opens for the selected database.

For SQL Server
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a. Server name - name of the SQL server (eg. AMXDB)

b. Initial catalog - name of the HSM database (e.g. MAMUSER which is the default name of

the Archive Manager for Exchange database)

c. Schema name - name of the SQL schema (e.g. dbo)

d. Authentication – authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

e. Username - database login username if SQL Server authentication is the selected as the

authentication mode.

f. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

For Oracle

a. Oracle net name - net service name that describes the network address of the database

server in your tnsnames.ora file (eg. AMXDB).

b. Schema - name of the Auditing schema (e.g. MAMUSER which is the default name of the

Archive Manager for Exchange database).

c. Username - database login username.

d. Password -  password of the database user.

5. Click Next and then click Yes on the confirmation dialog that opens.

6. If the database connection is setup successfully, the configuration confirmation window

opens.

7. Click Finish to close the Database Connection wizard.

Steps to install the User database

1. From the feature panel on the left in the Archive Manager Configuration wizard, click Auditing

and select the Database tab.

2. Verify that the database connection information is as expected. Then click Run Scripts. The

Run Scripts selection window opens.

3. Click Select All to select all check boxes. Click Next. The View SQL scripts window opens.

4. Click Next. The Run Scripts authentication window opens.

5. Enter the information as described below:

a. Authentication - authentication type used for the database. Choose either Windows

authentication or SQL Server authentication

b. Database user - database login username if SQL Server authentication is the selected as the

authentication mode.
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c. Password - password of the database user if SQL Server authentication is the selected as

the authentication mode.

d. (optional) Check the I want to review the SQL Scripts check box to view the scripts.

6. Click Next. If you chose to view the SQL scripts then the View SQL scripts window opens. If you

chose to view the Oracle scripts then the View Oracle scripts window opens

7. Click Save Script to save the script as a script file to a folder. Check the Word wrap check box to

display long lines as multiple lines of text.

8. Click Next. The Run SQL scripts window reopens with the scripts you have chosen to run.

9. Click Next. When the status changes to Scripts were run successfully, click Finish to close the

script installer. The Scripts section of the Archive Manager Configuration wizard displays the

status and version of the scripts.

10. Close the Archive Manager Configuration wizard.

Steps to start the  Archive Manager for Exchange services

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 2 to start the services.

NOTE: To start or stop the services at any time you can use the Start Stop Archive

Manager Services tool. For more information, see Starting and Stopping Services.
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Steps to set the Retrieve Server role
Unless you manually change the role, every installation of the Archive Manager for Exchange will

automatically assign the Archive Server role to the installed instance. You must set the Retrieve

Server role for this server.

1. If the Post installation Tasks wizard is not already open, you can open the the Post installation

Tasks wizard from C:\Program Files (x86)
\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe.

2. Click Start next to step 3 of the the Post installation Tasks wizard to open the AMAC. You can

also open the AMAC from Start > Archive Manager for Exchange. The AMAC opens.

3. From the Tools menu select Options. The Options window opens.

4. From the Select the server role drop down list, select Retrieve Server.

5. Click OK to set the server role and close the window and restart the server.

Steps to verify the Retrieve Server role
1. Login to the server with the credentials of the superuser (eg. democorp\mamadmin)

2. Click Start > Archive Manager for Exchange. The AMAC opens.
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On the status bar at the bottom of the AMAC window, verify that the Server Role is set to

Retrive Server.
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Setup Address Book and Forms

7

In this chapter

· Setup the Address Book

· Publish Archive Manager Forms

Setup up the Address Book
You must import the Microsoft Exchange servers, mailboxes and groups and keep them in synch

to facilitate email archiving. With the Address Book Manager, you can import the servers,

mailboxes and groups and schedule automatic synchronization jobs to keep the Archive Manager

for Exchange database up to date and synchronized with the Active Directory.

In this chapter:

· Steps to open the Address Book Manager

· About the Address Book Manager

· Importing Exchange Servers

· Importing Mailboxes

· Importing or Creating Groups

· Synchronizing Address Book Manager

Steps to open the Address Book Manager
1. Log in to the Archive Manager for Exchange Administration Center (AMAC).

2. From the Tools menu, click Address Book Manager.
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or, from the toolbar, click Address Book Manager

3. If no Microsoft Exchange servers, mailboxes or groups are available in the Address Book

Manager, the Address Book Setup wizard opens. Otherwise the Address Book Manager

window opens.

About the Address Book Manager
The Address Book Manager window provides two menu options:

Setup - starts the Address Book Setup wizard that provides a step-by-step guide to add Microsoft

Exchange servers, mailboxes and groups. If no Microsoft Exchange servers, mailboxes or groups

are available in the Address Book Manager, the Address Book Setup wizard opens by default

when you open the Address Book Manager.

Refresh - reloads information about Microsoft Exchange servers, mailboxes and groups based on

the available configuration settings.

The management of Microsoft Exchange servers, mailboxes, groups and synchronization settings

are organized by tabs in the Address Book Manager window.

· Synchronization – for manual or automatic synchronization of mailboxes, groups and

permissions with the Active Directory of available servers. 

· Servers – for adding, removing and managing Microsoft Exchange servers.

· Groups – for importing groups, creating user-defined groups and managing group features.

· Mailboxes – for importing new mailboxes and managing mailboxes.
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Importing Exchange Servers

In this topic:

Options for importing Microsoft Exchange servers

Steps to add on-premise Microsoft Exchange servers

Steps to add Microsoft Online

Steps to verify the imported Microsoft Exchange servers

Options for importing Microsoft Exchange servers
Microsoft Exchange Servers can be added to the Address Book Manager in one of two ways:

· Option 1 - By using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book setup wizard opens.

3. Click the Launch server wizard to initiate the import process.
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· Option 2 - By starting a task from the Servers tab of the Address Book Manager. 

1. Open the Address Book Manager.

2. Click the Servers tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Add

Server to initiate the import process.

Whichever method you choose, the Select Exchange Server Type window opens.

Steps to add on-premise Microsoft Exchange servers
1. In the Select Exchange Server Type window, select Import Exchange Server.
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2. Click Next. A list of Microsoft Exchange Servers appear that are accessible within your trusted

domain. 

Select the servers that contain the mailboxes and folders you want to archive and then select

the check boxes to set the permissions as described below:

a. Set Exchange server permissions for <Exchange server online superuser> - grants elevated

rights to the Exchange server online superuser on each of the selected servers.

b. Set Public Folder permissions for <Exchange server online superuser> - grants OWNER

permission for the Public Folders to the Exchange serve online superuser.

3. Click Next. The Superuser's mailbox SMTP address window opens. In the Superuser's mailbox

SMTP address field, enter the email address of the superuser if not already filled in. You can

change the email from the server Properties window.
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4. Click Next. The Summary window opens that lists the on-premise servers that will be added.

5. Click Finish to start the import process. The Creating objects window opens. You can click Back

to select more servers to add or remove some of the selected servers.
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6. When the import process has completed, click Close.

Steps to add Microsoft Online
NOTE: You must register your Quest application in Microsoft Entra ID. For more details, see

Registering Quest in Microsoft Entra ID for EWS.

1. From the Address Book Setup wizard, click the Launch server wizard to initiate the server

import process.

2. In the Select Exchange Server Type window, select Import Exchange Online.

3. Click Next. The Credentials for Exchange Online window opens. Specify the information as

described below:
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a. Username - username of the administrator.

b. Client ID - the Application ID that you copied from Microsoft Entra ID.

c. Client secret - the Client Secret value that you copied from Microsoft Entra ID.

d. Endpoint type - select from the following options:

· Worldwide endpoints - endpoints for worldwide Microsoft 365 subscriptions, which

include the United States Government Community Cloud (GCC).

· U.S. Government DoD endpoints - endpoints for United States Department of Defense

(DoD) subscriptions.

· U.S. Government GCC High endpoints - endpoints for United States Government

Community Cloud High (GCC High) subscriptions.

4. Click Next. The Available Exchange Servers window opens. Select the Office 365 instance. You

can click Back to select more servers to add or remove some of the selected servers.
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5. Set the permission as described below:

· Set Public Folder permissions for <Exchange server online superuser> - grants OWNER

permission for the Public folders to the Exchange serve online superuser.

6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that

will be added.

7. Click Finish to start the import process. The Creating object window opens.

8. When the import process has completed, click Close.

Steps to verify the imported Microsoft Exchange
servers
1. Open the Address Book Manager
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2. Click the Servers tab and verify the imported servers in the list view.

Importing Mailboxes

In this topic:

Options for importing mailboxes

Steps to import mailboxes from on-premise Microsoft Exchange servers

Steps to import mailboxes from online Microsoft Exchange servers

Steps to verify the imported mailboxes

Options for importing mailboxes
Microsoft Exchange server mailboxes can be added to the Address Book Manager in one of two

ways:

· By using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book Setup wizard opens.

3. Click the Launch mailbox wizard to initiate the import process.
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· By using the Mailboxes tab of the Address Book Manager. 

1. Open the Address Book Manager.

2. Click the Mailboxes tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Import

mailbox wizard to initiate the import process.

Whichever method you choose, the Import mailbox wizard window opens.
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Steps to import mailboxes from an on-premise
Microsoft Exchange Server
1. In the Select Exchange Server Type window, select Import from Exchange On-Premise.

2. Click Next. The Mailboxes - search and select mailboxes to import window opens. 

3. Click Search to return the list of all mailboxes across all on-premise servers available to the

Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the

Look for Name search box. Only the initial letters of the mailbox Display Name can be

specified, and wildcards are not supported. The search term is case-insensitive. For example,

if you enter ni as the search term and click Search, the mailboxes that start with the letters ni

will be returned in the search results list.

4. Select one or more mailboxes that you want to import.
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NOTE: Mailboxes that are highlighted indicate that they already exist in the Address

Book Manager. The list summary above the list of mailboxes will indicate how many

mailboxes that you select are new, and how many already exist. If you select pre-

exisiting mailboxes, they will be updated during the import process..

5.  Click Next. The Summary window opens that lists the mailboxes from the on-premise

Microsoft Exchange servers that will be imported.

6. Click Finish to start the import process. The Creating Object window opens. You can click Back

to select more mailboxes to add or remove some of the selected mailboxes.

7. When the import process has completed, click Close.
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Steps to import mailboxes from an online Microsoft
Exchange Server
1. In the Select Exchange Server Type window, select Import from Exchange Online.

2. Click Next. The Exchange Online window opens. Select the desired Office 365 instance. 

3. Click Next. The Mailboxes - search and select mailboxes to import window opens. 
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4. Click Search to return the list of all mailboxes across all on-premise servers available to the

Address Book Manager. To reduce the list of mailboxes, you can specify a search term in the

Look for Name search box. Only the initial letters of the mailbox Display Name can be

specified, and wildcards are not supported. The search term is case-insensitive. For example,

if you enter A as the search term and click Search, the mailboxes that start with the letter A

will be returned in the search results list.

5. Select one or more mailboxes that you want to import.

NOTE: Mailboxes that are highlighted indicate that they already exist in the Address

Book Manager. The list summary above the list of mailboxes will indicate how many

mailboxes that you select are new, and how many already exist. If you select pre-

exisiting mailboxes, they will be updated during the import process.

6. Click Next. The Summary window opens that lists the online Microsoft Exchange servers that

will be added.
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7. Click Finish to start the import process. The Creating Object window opens. You can click Back

to select more mailboxes to add or remove some of the selected mailboxes.

8. When the import process has completed, click Close.

Steps to verify the imported mailboxes
1. Open the Address Book Manager

2. Click the Mailboxes tab and verify the imported mailboxes in the list view.

NOTE: Mailboxes with names like public_<name-of-Microsoft-Exchange-server> also

appear in the mailboxes list These mailboxes are the public folders from the respective
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Microsoft Exchange server because Address Book Manager considers a public folder as a

profile. These mailboxes are always highlighted in blue  so that you can distinguish them

faster. Imported mailboxes must be added to a group in Address Book Manager to allow

automatic archiving with scheduled jobs. If you do not add mailboxes to a group you can

archive them manually.

Importing or Creating Groups

Groups allow you to schedule archiving jobs. There must be at least one group (either imported

from Active Directory or a user-defined group) if you plan to schedule archiving jobs. User-

defined groups are not Active Directory groups.

In this topic:

Options for importing groups

Steps to import groups from on-premise Microsoft Exchange servers

Steps to import groups from online Microsoft Exchange servers

Steps to create user-defined groups

Steps to verify the imported and user-defined groups

Options for importing groups
Microsoft Exchange server groups can be added to the Address Book Manager in one of two ways:

· By using the Address Book Setup Wizard.

1. Open the Address Book Manager.

2. From the Setup menu, click Setup Wizard. The Address book Setup wizard opens.

3. Click the Launch group wizard to initiate the import process.
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· By using the Groups tab of the Address Book Manager. 

1. Open the Address Book Manager.

2. Click the Groups tab.

3. Right-click inside the list view and from the context menu point to Tasks and select Add

group wizard to initiate the import process.

Whichever method you choose, the Import group wizard window opens.
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Steps to import groups from an on-premise
Microsoft Exchange Server
1. In the Import group wizard window, select Import Groups.

2. Click Next. The Exchange type selection window opens. Select Import form Exchange On-

Premise.

3. Click Next. The Groups - search and select groups to import window opens. 
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4. Click Search to return the list of all groups across all on-premise servers available to the

Address Book Manager. To reduce the list of groups, you can specify a search term in the Look

for Name search box. Only the initial letters of the groups Display Name can be specified, and

wildcards are not supported. The search term is case-insensitive. For example, if you enter D

as the search term and click Search, the groups that start wit the letter D will be returned in

the search results list. 

5. Select one or more groups that you want to import.

NOTE: Groups that are highlighted indicate that they already exist in the Address Book

Manager. The list summary above the list of groups will indicate how many groups that

you select are new, and how many already exist. If you select pre-exisitng groups, all

new mailboxes will also be imported.

6. Click Next. The Group settings - default values window opens.

7. Specify the settings which will be applied when the groups are imported now or synchronized

in future with the Address Book Manager automatically or manually. The settings are

described below:



177
Setup Address  Book and Forms

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

a. Automatically import mailbox members - check this box to import all Active Directory

accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup

mailbox members. You can activate this setting only if you select the Automatically import

mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of

selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member

mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent

group in the Address Book Manager.

8. Click Next. The Summary window opens that lists the groups that will be added.

9. Click Finish to start the import process. The Creating Object window opens.

10. When the import process has completed, click Close.
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Steps to import groups from an online Microsoft
Exchange Server
1. In the Import group wizard window, select Import Groups.

2. Click Next. In the Exchange Type selection window, select Import from Exchange Online.

3. Click Next. The Exchange Online window opens. Select the desired online Microsoft Exchange

server.
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4. Click Next. The Groups - search and select groups to import window opens. 

5. Click Search to return the list of all groups across all online servers available to the Address

Book Manager. To reduce the list of groups, you can specify a search term in the Look for

Name search box. Only the initial letters of the group Display Name can be specified and

wildcards are not supported. The search term is case-insensitive.

NOTE: Groups that are highlighted indicate that they already exist in the Address Book

Manager. The list summary above the list of groups will indicate how many groups that

you select are new, and how many already exist. If you select pre-existing groups, all

new mailboxes in those groups will also be imported.

6. Select the groups that you want to import.

7. Click Next. The Group settings - default values window opens
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8. Specify the settings which will be applied when the groups are imported now or synchronized

in future with the Address Book Manager automatically or manually. The settings are

described below:

a. Automatically import mailbox members - check this box to import all Active Directory

accounts with a mailbox that are members of this group.

b. Advanced import settings - check this box if you intend to import subgroups and subgroup

mailbox members. You can activate this setting only if you select the Automatically import

mailbox members setting.

c. Import subgroups along with members - check this box to import existing subgroups of

selected groups including its member mailboxes. This is the default setting.

d. Import only mailbox members without subgroups - check this box to import only member

mailboxes from subgroups. These mailboxes will be added to mailboxes in the parent

group in the Address Book Manager. 

9. Click Next. The Summary window opens that lists the groups that will be added.
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10. Click Finish to start the import process. The Creating objects window opens. You can click Back

to select more groups to add or remove some of the selected groups.

11. When the import process has completed, click Close.

Steps to create user-defined groups
1. In the Import group wizard window, select Create user defined group. Enter a name for the

group in the Group Name field.

2. Click Next. The User Defined Group - Add members to group window opens. By default, the

on-premise Microsoft Exchange server is the source for the list of mailboxes and groups that

can be added to the user-defined group. To use O365 Exchange servers as a source for

mailboxes and groups, select Exchange Online. 
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3. Click Search to return the list of all mailboxes and groups. To reduce the list of mailboxes and

groups, you can specify a search term in the Look for Name search box. Only the initial letters

of the mailbox or group Display Name can be specified and wildcards are not supported. The

search term is case-insensitive.

NOTE: If the Exchange Online check box is checked, only the online Microsoft Exchange

servers will be used as the source. If the Exchange Online check box is unchecked, only

on-premise Microsoft Exchange servers will be used as the source.  Mailboxes and

groups that are highlighted indicate that they already exist in the Address Book

Manager. The list summary above the list of groups will indicate how many mailboxes

and groups are available.

4. Select one or more mailboxes and groups that want to add to the user-defined group. If you

select one or more groups, all mailboxes in that group will also be add to the user-defined

group during the import process.

5. Click Next. The Summary window opens that indicates the user-defined group that will be

created.
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6. Click Finish to start the group creation process. The Creating Object window opens. You can

click Back to revise your selection of mailboxes and groups.

7. When the import process has completed, click Close.

Steps to verify the imported and user-defined groups
1. Open the Address Book Manager

2. Click the Groups tab and verify that the imported Active Directory and user-defined groups

appear in the list view as expected. User-defined groups are highlighted in green .
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3. Select a group and right-click to open the context menu. Click Properties. The Properties

window of the selected group opens.

4. Click the Members tab and verify that the list of mailboxes were imported as expected.

Synchronizing Address Book Manager

Synchronization with the Microsoft Exchange servers keeps groups and mailboxes up to date so

that emails can be archived without problems. With the Address Book Manager, you can set up

automatic synchronization schedules and initiate manual synchronization of various artifacts. 

In this topic:

Steps to perform a manual synchronization

Steps to schedule automatic synchronization

Steps to perform a manual synchronization
1. Open Address Book Manager by clicking the toolbar icon  or clicking Address Book Manager

from the Tools menu.

2. The Synchronization tab opens by default.
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3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to

synchronize.

4. In the Select servers box, select the Microsoft Exchange servers with which you want to

synchronize the mailboxes, groups and permissions.

5. Click Apply to confirm the settings.

6. Click Sync Now in the Microsoft Exchange Synchronization box to manually initiate the

synchronization of the mailboxes and groups with the selected Microsoft Exchange servers.

7. Click Stop to halt the synchronization process before it completes. When the process

completes, click the Close button that opens. You can find the results of the synchronization

process in a log file located at C:\Program Files (x86)
\Quest\MAM4Exchange\Log\Synchronization_<timestamp>.log
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8. Click Sync Now in the Microsoft Exchange Permissions Synchronization box to manually initiate

the synchronization of the mailboxes and groups with the selected Microsoft Exchange

servers.

9. Click Stop to halt the synchronization process before it completes. When the process

completes, click the Close button that opens. You can find the results of the synchronization

process in a log file located at C:\Program Files (x86)
\Quest\MAM4Exchange\Log\Synchronization_<timestamp>.log

Steps to schedule automatic synchronization
1. Open Address Book Manager by clicking the toolbar icon  or clicking Address Book Manager

from the Tools menu.

2. The Synchronization tab opens by default.
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3. Select the Microsoft Exchange mailboxes, groups and permissions that you want to

synchronize.

4. In the Select servers box, select the Microsoft Exchange servers with which you want to

synchronize the mailboxes, groups and permissions.

5. Click Schedule in the Microsoft Exchange Synchronization box. The Microsoft Exchange

Synchronization Scheduler dialog opens.

6. Select Use scheduled synchronization to activate the synchronization calendar. Each row

corresponds to a day of the week. Each column corresponds to an hour of the day (24-hour

clock).

7. To set up a schedule using the synchronization calendar, click the cell that corresponds to the

day of the week and the hour of day when you want the scheduler to initiate a

synchronization job. For example, in the figure above, the synchronization schedule is set to
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start at 18:00 hrs (6 pm) every weekday. The time zone of the computer where the application

is running will be used to determine the time.

NOTE: If you select consecutive cells in a single row, synchronization will start

automatically every hour on the hour. It will consume unnecessary processing time and

is not recommended.

8. Click OK to save the schedule or Cancel to discard the setup.

9. You can find the results of the scheduled synchronization process in a log file located at C:
\Program Files (x86)

\Quest\MAM4Exchange\Log\Synchronization_<timestamp>.log

Publish Archive Manager Forms
Archive Manager Forms are a set of custom Outlook forms that are used to display and work with

archived emails. You can choose to publish these custom forms to the Organizational Forms

Library of your on-premise Exchange Server, or publish these forms to the Personal Forms Library

of each user whether they use an on-premise Exchange Server or the online Exchange server

(O365). 

This topic describes the steps to use the Forms Installer to publish the Archive Manager Forms

directly to the Organizational Forms Library of your on-premise Exchange server, or prepare the

the Archive Manager Forms for publishing to the Personal Forms Library of each on-premise or

O365 user registered in the domain active directory using the Group Policy Object (GPO).

· Publish Forms to Organizational Forms Library

· Publish Forms to Personal Forms Library

Publish Forms to Organizational Forms Library

In this topic:

· Steps to publish forms to the Organization Forms Library

· Steps to activate Archive Manager forms in mailboxes

Steps to publish forms to the Organization Forms Library

NOTE: It is assumed that the Organizational Forms Library exists on the on-premise

Exchange Server. For more information see Setup the Organizational Forms Library.

1. Log in to the server where Archive Manager for Exchange (designated the Archive server is a

distributed deployment) was installed (eg. AMXSERVER-A) with the credentials of the

superuser (eg. democorp\mamadmin)

2. To open the Outlook Forms Setup wizard do one of the following:
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· If the Post installation Tasks wizard is not already open, you can open the the Post

installation Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe and then click Start

next to step 2 to start the installer.

· Start the forms installer directly from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\Forms\FormsInstaller.exe.

3. Select Install/repair and then click Next. The Outlook Forms Setup - Folder Location window

for the form template opens.

The default location is displayed. Click Browse to locate the template folder if you have

moved the templates to a different location.
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4. Click Next. The Outlook Forms Setup - Form Selection window open.

Select all the forms from the Available forms list and move it to the Selected forms list. 

5. Click Next. The Outlook Forms Setup - Activate/deactivate Outlook forms events window

opens.

Keep the default selections on this page unless you want to change the behavior as described

below:

a. On Open - When checked, this option presents a shortcut that can be clicked to download

the archived email but deactivates the ability to use the Previous Item and Next Item

functionality in Outlook because archived emails are offline copies and are not aware of

previous or next emails. When unchecked, the archived email cannot be downloaded or

viewed.
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b. On Reply - When checked, the content of the email is included in the reply to the sender of

the original email. When unchecked, the shortcut to the archived email is included in the

reply message and can be accessed only by members of the Exchange server. 

c. On Reply to All - When checked, the content of the email is included in the reply to

recipients of the original email. When unchecked, the shortcut to the archived email is

included in the reply message and can be accessed only by members of the Exchange

server.

d. On Forward - When checked, the content of the email is forwarded to the new recipient(s)

of the original email. When unchecked, the shortcut to the archived email is forwarded to

the new recipient and can be accessed only by members of the Exchange server. 

6. Click Next. The Outlook Forms Setup - Retrieve servers identification window opens.

Specify the information as described below:

a. Location ID - Each Archive Manager for Exchange server is bound to a single location

identified by the Location Id. 

b. Primary Retrieve Server - If the deployment topology has just one standalone Archive

Manager for Exchange server then enter the NetBIOS name of the standalone server. If the

deployment topology has a dedicated Archive Manager for Exchange server with the

Retrieve role, then specify the NetBIOS name of the Retrieve server (eg. AMXSERVER-R).

c. Secondary Retrieve Server - For a standalone deployment topology, enter an alternate

identifier (eg. IP address) of the same server. For a dedicated Retrieve server specify the

NetBIOS name of the Archive server.
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Examples:

Topology Primary Retrieve Server Secondary Retrieve Server

Standalone Archive server NetBIOS name of the

Archive server (eg.

AMXSERVER)

IP address of the Archive

server (eg. 10.20.30.40)

Dedicated Archive and

Retrieve servers

NetBIOS name of the

Retrieve server (eg.

AMXSERVER-R)

NetBIOS name of the

Archive server (eg.

AMXSERVER-A)

Load-balanced Retrieve

servers

NetBIOS name of the load

balancer

IP Address of the load

balancer

7. Click Next. The Outlook Forms Setup - Retrieval settings window opens.

The options are as described below:

a. Use SSL (https) in server connection - Select this option only if the Exchange server

communication uses SSL.

b. Open message as read-only - When checked, archived emails are opened in read-only

mode. When this option is unchecked, users are allowed to modify archived emails but

these changes are not updated in the archive. Users with Archive Manager Outlook Addin

installed can modify archived emails by creating new email versions in the archive even if

the Open message as read-only check box is selected.



193
Setup Address  Book and Forms

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

8. Click Next. The Outlook Forms Setup - Publishing forms window opens.

9. Click Next. The Outlook Forms Setup - Summary window opens.
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10. Verify the settings or click Back to revise the settings. Click Install to publish the forms. The

Outlook Forms Setup - Install progress window opens.

When the forms are published click Finish. 

11. To verify that the forms were published to the Organizational Forms Library in the Exchange

server, open an Outlook client account connected to the Exchange server. From the Home tab

click New Items > More Items > Choose Form. In the Look In list, click Organizational Forms

Library and view the published forms.
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Steps to activate Archive Manager forms in mailboxes

After publishing the forms, it is recommended to activate any one Archive Manager form for all

users to ensure that the forms are immediately available to the users.

1. Open Outlook on the Archive Manager server with your administrator or super-user

credentials.

2. Click the Home tab and navigate to New Items > More Items > Choose Form.

3. Choose Organizational Forms Library from the Look in drop down. 

4. Select the PamMessage form that has the archived email icon in the Description (to display

the icon click Advanced)

5. Click and hold the SHIFT-key and double-click to load the form. The form opens like a normal

email.

6. Send this email to all mailboxes you plan to archive. When users receive the email, the new

set of custom forms in the Organizational Forms Library will be available to the users.

NOTE: 

a. If there are multiple languages (multiple organizational form libraries), then you need to

publish the forms using a language specific Outlook and account – one for each language.

b. To replicate the Archive Manager forms in the Public Information Store, use an Archive

Manager form to send an email to your Inbox folder. Then copy or move the email to the

Public Folder you wish to archive. The Archive Manager forms are replicated in the Public

Information Store too.
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Publish Forms to Personal Forms Library

In this topic:

· Steps to prepare forms for publishing

· Steps to install the Forms Publisher to publish forms

· Steps to use the Forms Publisher to publish forms

· Steps to use the Group Policy Object (GPO) to publish forms

Steps to prepare forms for publishing

1. Log in to the server where Archive Manager for Exchange (designated the Archive server is a

distributed deployment) was installed (eg. AMXSERVER-A) with the credentials of the

superuser (eg. democorp\mamadmin)

2. To open the Outlook Forms Setup wizard do one of the following:

· If the Post installation Tasks wizard is not already open, you can open the the Post

installation Tasks wizard from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\LaunchTools\LaunchTools.exe and then click Start

next to step 2 to start the installer.

· Start the forms installer directly from C:\Program Files (x86)

\Quest\MAM4Exchange\Tools\Forms\FormsInstaller.exe.
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3. Select Install/repair and then click Next. The Outlook Forms Setup - Folder Location window

opens.

The default location is displayed. Click Browse to locate the template folder if you have

moved the templates to a different location

4. Click Next. The Outlook Forms Setup - Form Selection window opens.

Select all the forms from the Available forms list and move it to the Selected forms list. 
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5. Click Next. The Outlook Forms Setup - Activate/deactivate Outlook forms events window

opens.

Keep the default selections on this page unless you want to change the behavior as described

below:

a. On Open - When checked, this option presents a shortcut that can be clicked to download

the archived email but deactivates the ability to use the Previous Item and Next Item

functionality in Outlook because archived emails are offline copies and are not aware of

previous or next emails. When unchecked, the archived email cannot be downloaded or

viewed.

b. On Reply - When checked, the content of the email is included in the reply to the sender of

the original email. When unchecked, the shortcut to the archived email is included in the

reply message and can be accessed only by members of the Exchange server. 

c. On Reply to All - When checked, the content of the email is included in the reply to

recipients of the original email. When unchecked, the shortcut to the archived email is

included in the reply message and can be accessed only by members of the Exchange

server.

d. On Forward - When checked, the content of the email is forwarded to the new recipient(s)

of the original email. When unchecked, the shortcut to the archived email is forwarded to

the new recipient and can be accessed only by members of the Exchange server. 
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6. Click Next. The Outlook Forms Setup - Retrieve servers identification window opens.

Specify the information as described below:

a. Location ID - Each Archive Manager for Exchange server is bound to a single location

identified by the Location Id. 

b. Primary Retrieve Server - If the deployment topology has just one standalone Archive

Manager for Exchange server then enter the NetBIOS name of the standalone server. If the

deployment topology has a dedicated Archive Manager for Exchange server with the

Retrieve role, then specify the NetBIOS name of the Retrieve server (eg. AMXSERVER-R).

c. Secondary Retrieve Server - For a standalone deployment topology, enter the same

NetBIOS name or IP address of the standalone Archive server. If the deployment topology

has a dedicated Archive Manager for Exchange server with the Archive role then specify the

NetBIOS name of the Archive server.

Examples:

Topology Primary Retrieve Server Secondary Retrieve Server

Standalone Archive server NetBIOS name or IP address

of the Archive server (eg.

AMXSERVER)

NetBIOS name or IP address

of the Archive server (eg.

AMXSERVER)

Dedicated Archive and

Retrieve servers

NetBIOS name or IP address

of the Retrieve server (eg.

AMXSERVER-R)

NetBIOS name or IP address

of the Archive server (eg.

AMXSERVER-A)

Load-balanced Retrieve

servers

NetBIOS name or IP address

of the load balancer

NetBIOS name or IP Address

of the load balancer
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7. Click Next. The Outlook Forms Setup - Retrieval settings window opens.

The options are as described below:

a. Use SSL (https) in server connection - Select this option only if the Exchange server

communication uses SSL.

b. Open message as read-only - When checked, archived emails are opened in read-only

mode. When this option is unchecked, users are allowed to modify archived emails but

these changes are not updated in the archive. Users with Archive Manager Outlook Addin

installed can modify archived emails by creating new email versions in the archive even if

the Open message as read-only check box is selected.

8. Click Next. The Outlook Forms Setup - Publishing forms window opens. Clear the checkbox

Publishing forms to the Organizational Forms Library.
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9. Click Next. The Outlook Forms Setup - Summary window opens.

10. Click Install to prepare the forms for publishing. The Outlook Forms Setup - Install progress

window opens.

11. When the forms are prepared for publishing click Finish. When you complete this step, the

Archive Manager forms are ready to be published to the Personal Forms Library. 
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Steps to install the Forms Publisher to publish forms

1. Open <Media-folder>\Archive Manager Installation Package\Exchange\Addin

and run the Archive Manager Forms Publisher Setup.msi installer.

2. Click Next. The Destination Folder window opens.
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3. Click Change to revise the location of the installation folder, or click Next to continue. The

Ready to Install the Program window opens.

4. Click Install. When the installation completes, the InstallShield Wizard Completed window

opens.

If you wish to publish the forms to the Personal Forms Library immediately, select the

checkbox Launch Forms Publisher and click Finish. Then follow the steps in the next section to

publish the forms. If you clear the checkbox, you can start the Form Publisher form the Start

menu > Quest > Form Publisher.
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Steps to use the Forms Publisher to publish forms

1. If the Forms Publisher is not already opened, start the Form Publisher form the Start menu >

Quest > Form Publisher. The Forms Publisher window opens. 

2. Click Install to publish the forms to the Personal Forms Library.

3. Click Close to exit the Forms Publisher.

4. Verify that the custom forms are present in the Personal Forms Library.
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Steps to use the Group Policy Object (GPO) to publish forms

The steps to set up the GPO has three stages:

· Create a shared folder on the domain controller for the Forms Publisher installer

· Create a registry item to store the web service URL that will be invoked by the Forms Publisher

· Create a GPO to distribute the Forms Publisher Setup to intended users

Create a shared folder on the domain controller for the Forms Publisher
installer

1. Log in to your domain controller and open Server Manager. 

2. Create a shared folder called Forms Publisher. Share it with all intended users with the Read

permission. Note the UNC path of the shared folder

3. Copy and paste the Archive Manager Forms Publisher Setup.msi installer to your shared

folder. This file is already in your Archive Manager server at this location: <shared-media-
folder>\Archive Manager Installation Package\Exchange\Addin



206
Setup Address  Book and Forms

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

Create a registry item to store the web service that will be invoked by the
Forms Publisher

CAUTION: The following steps are instructions to modify the registry of the domain controller.
Serious problems might occur if you modify the registry incorrectly by using the Registry
Editor or by using another method.

1. Open the Registry. Expand HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node and create a

new key named Quest.

Create a GPO to distribute the Forms Publisher Setup to intended users

1. Click Tools and then click Group Policy Management. The Group Policy Management window

opens.

2. Expand the console tree Forest > Domains > <YourDomain> and click Group Policy Objects.
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3. Right click in the Group Policy Object pane, and click New from the context menu. The New

GPO window opens.

Enter the information as described below:

a. Name - enter a unique name to describe the policy. For example, enter Publish Archive

Manager Forms.

b. Source Starter - (none).

c. Click OK to save the new GPO.

4. Right click your domain name and then click Link an Existing GPO from the context menu. The

Select GPO window opens.
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5. Choose the GPO that you created and then click OK.

6. Right-click the GPO you created and then click Edit. The Group Policy Management Editor

opens.



209
Setup Address  Book and Forms

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

7. Navigate to User Configuration > Policies > Software Settings > Software Installation. Then

right-click Software Installation to open the context menu. Click New and then click Package.

8. Browse to the shared folder you created in a step 2 above, and select the Archive Manager

Forms Publisher Setup.msi installer.
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9. Click Open. The Deploy Software window opens. Select the Advanced option.

10.  Click OK.  The Forms Publisher Installer Properties window opens. Click the Deployment tab.
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Set the properties as described below:

a. From the Deployment type section, select the Assigned option.

b. From the Deployment options section, select the Install this application at logon options

check box.

11. Click OK to close the Forms Publisher Installer Properties window, and verify that application

appears in the Group Policy Management Editor.

12.  From the Group Policy Management Editor expand Computer Configuration > Preferences >

Windows Settings and then click Registry. 
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13.  Right-click in the items pane to open the context menu. Then select New > Registry Item. The

new Registry Properties window opens.

 In the new Registry Properties window create a new registry item with the following values:

a. Action - select Create from the drop down.

b. Hive - select HKEY-LOCAL_MACHINE from the drop down.



213
Setup Address  Book and Forms

Quest® Archive Manager for Exchange Advanced Insta l l  Guide

c. Key Path - enter SOFTWARE\Wow6432Node\Quest

d. Value name - enter DownloadFormsService

e. Value type - select REG_SZ from the drop down.

f. Value data - enter the address to web service which will download forms in the format

http://<Archive-Manager-Server>/ExchangePAMWS/GetForm.aspx

14. Click OK to save the registry item. Verify that the registry item appears in the registry items

list. Then exit the Group Policy Management Editor and the Group Policy Management tool.

NOTE: The user policy will not take effect until a fresh logon occurs after a reboot of the

user's computer.

15. Verify that the GPO publishes the Archive Manager Forms to the Personal Forms Library when

they log in to their computers.
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Installation Verification

8

When you have completed the installation and configuration as described in this guide, log on to

the Archive server (eg. AMXSERVER-A) as the superuser and open Outlook. Send a couple of

emails, in order to see if you can read them.

Steps to verify your installation

1. Open the AMAC.

2. Click the View menu on the toolbar and select the Archive view.

3. In the Look for text field type the name of one of your synchronized mailboxes and click Enter.

4. After expanding the mailbox structure you will be able to see the list of emails in the right-

pane of the AMAC.

5. Right-click any email from a mailbox and choose Archive item from the context menu.

6. If the archiving process ends with the following dialog you have successfully managed to

archive your first email.
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Archive Manager for Exchange can be extended with optional components to enhance its

capabilities. 

Steps to install additional components

1. From your installation media folder, run the MAMInstaller.exe. The Welcome window

appears.

2. From the navigation panel on the left, click SETUPS. The Setups window appears. 

3. Install one or more optional components. The components are as follows

· Archive Manager Universal Access Setup - allows mobile users, Mac users and Linux users to

work with archived emails. For more information see the Universal Access Install Guide.

· Archive Manager OWA Extension Setup - component that is installed on the Microsoft

Exchange Server to provide Outlook Web Access to end-users. For more information see the

Outlook Web Access Guide.

· Archive Manager SMTP Setup  - allows processing of messages from an external email

server (O365, Gmail, Exchange, etc.). For more information see the SMTP Guide.

· Archive Manager PST Gatherer Setup - automated extension to the PST importer feature.

For more information see the PST Importer Guide.
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· Archive Manager Outlook Addin <version> Setup -  gives authorized users the ability to

archive and restore emails in Outlook 2016 and above (x86 or x64). For more information

see the Outlook Add-in Installation Guide.
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· Organizational Forms Library troubleshooting

· License Activation

Organizational Forms Library troubleshooting
Sometimes the Organizational Forms Library may not be accessible in Outlook after Archive

Manager for exchange installation. This error may occur if there are too many mailboxes with full

access permission for the given user and as a result, Public Folders become inaccessible. To

address this error, use the following workaround:

1. Close Outlook.

2. In the Exchange server, open Exchange Management Shell.

3. Run the following command where #USERALIAS is alias  for given user and #USEREMAIL is the

email address of the given user: 

Get-Mailbox -ResultSize unlimited -Filter {(RecipientTypeDetails -eq
'UserMailbox') -and (Alias -ne '#USERALIAS')} | Remove-MailboxPermission
-User #USEREMAIL -AccessRights fullaccess -InheritanceType all

4. Open Outlook with the profile of the superuser. Now Organizational Forms Library should be

accessible.

5. (Optional) Open Exchange Management Shell and run the following command to give full

access permissions to all mailboxes to the superuser

Get-Mailbox -ResultSize unlimited -Filter {(RecipientTypeDetails -eq

'UserMailbox') -and (Alias -ne '#USERALIAS')} | Add-MailboxPermission -

User #USEREMAIL -AccessRights fullaccess -InheritanceType all

License Activation

Online activation

1. In the Activate License window, enter the license key.
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2. If you want to activate the license online, select Online Activation , and then click Next. 

NOTE: If your computer is behind a firewall, click the Set Proxy link. The Proxy Setup

dialog appears.

a. Select Activate Proxy and specify the proxy information as described below:

b. Server Name - enter the name of your proxy server.

c. Port - enter the port number of the proxy server.

d.  Username and Password - Specify the credentials of the user who is authorized

to access the proxy server.

e. Click Set to save the information, or click Close to return to the License Key

Information dialog.

3. If the license key is validated successfully, the confirmation message appears along with the

license details. Click Finish to close the dialog.

Offline activation

Offline activation is available for customers who want to review the information sent to Quest.

You will require an internet connection for this option as well.

1. In the Activate License window, enter the license key.

2. select  Offline Activation. The License Key Information window displays additional steps that

are required.
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3. Step 1: Collect the activation data to the clipboard or to a file

a. Select from the two options described below:

Option 1: Copy Activation Data to Clipboard. The activation data is saved to memory. Use

this option if you plan to follow through with the subsequent steps immediately.

Option 2: Click Save to File. The Windows File dialog appears. Specify a file name for the

activation data file and click Save to save the file to a location of your choice. Use this

option if you plan to activate the license at a later date.

4. Step 2: Submit collected data

a. Click Go. The Quest License Activation web page appears.

b. Follow the instructions to get the Activation Key file (with the file extension DAT) is made

available for download. Save this file to a location of your choice.

5. Step 3: Paste Activation Response

a. Click Load from File. The Windows file dialog appears.

b. Locate the activation key file and click Open. The text appears in the Activation Key File

field.
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6. Step 4: Activate offline

a. Click Next to complete the activation process.

7. If the license key is validated successfully, the confirmation message appears along with the

license details. Click Finish to close the dialog.

Registering in Microsoft Entra ID for EWS
1. Open https://entra.microsoft.com/ and login as administrator.

2. From the navigation pane, click Identity > Applications > App registrations and then New

registration.

3. Enter a meaningful application name that will be displayed to users. For example,

ArchiveManagerClient. From the Supported account types section, select Accounts in this

organizational directory only . Then click Register.

4. Your Your application is registered. Microsoft Entra ID assigns a unique Application (client) ID

to your application, and the application's Overview page opens.

IMPORTANT: Copy and save the Application (client) ID to Notepad and store it in a safe

place.

5. From the navigation menu, click Certificates & Secrets. In the Client secrets section click New

client secret. The Add a client secret page opens.

https://entra.microsoft.com/
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6. Enter values as described below:

a. Description - enter a meaningful description. For example, ArchiveManagerClient Secret.

b. Expires - set the expiry term that best meets your company policy.

7. Click Add. the client secret is displayed on the Certificates & Secrets page.

IMPORTANT: Copy and save the client secret value to Notepad and store it in a safe

place. It will not be available when you navigate away from this portal.

8. From the navigation pane, click API permissions > Add a permission to open the Request API

permissions window. Then click APIs my organization uses and select Office 365 Exchange

Online.

9. In the Request API permissions page, select Application permissions. Then select

full_access_as_app and Exchange.ManageAsApp. Then click Add permission to confirm your

selections.
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10. In the API permissions page, click Grant admin consent for Quest Software.

11. Before you start using the application you must assign the Exchange Administrator role to the

ArchiveManagerClient app.  Open the  app and click Roles and administrators.

12. From the navigation pane, go to Roles & Admins > Roles & Admins. Search for the Exchange

administrator role and double click it.
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13. Click Add assignments and find your application. For example, ArchiveManagerClient. Select it

and click Add to confirm.

14. Open the Archive Manager Administration Center and import Exchange Online server with

your Exchange Online administrator email, Client ID and Client secret.

Starting and Stopping Services
To start or stop Archive Manager for Exchange services:

1. Go to Start > Quest > Start Stop Archive Manager Services.

2. Select Exchange Services for Archive Manager for Exchange services only, or All Services.

3. Click Start to start services, or Stop to stop services.
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Quest creates software solutions that make the benefits of new technology real in an

increasingly complex IT landscape. From database and systems management, to Active Directory

and Office 365 management, and cyber security resilience, Quest helps customers solve their

next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune

500 count on Quest to deliver proactive management and monitoring for the next enterprise

initiative, find the next solution for complex Microsoft challenges and stay ahead of the next

threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and

customers who have trial versions. You can access the Quest Support Portal at

https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and

independently, 24 hours a day, 365 days a year. The Support Portal allows you to:

· Submit and manage a Service Request

· View Knowledge Base articles

· Sign up for product notifications

· Download software and technical documentation

· View how-to-videos

· Engage in community discussions

· Chat with support engineers online

· View services to assist you with your product

https://www.quest.com
http://www.quest.com/contact
https://support.quest.com

	Introduction
	System Requirements
	Deployment Plan
	About User Accounts
	Advanced Installation
	Setup the Superuser Account
	Prepare the Application Servers
	Steps to install the prerequisites
	Steps to install Microsoft Outlook
	Steps to download the install media

	Install the Application Features
	Install HSM and Archive Manager Search
	Install the Archive server
	Install the Retrieve server


	Manual Installation
	Setup the Superuser Account
	Modify the Exchange server throttling policy
	Setup the Organizational Forms Library
	Prepare the Application Servers
	Steps to install the prerequisites
	Steps to assign DCOM access and launch permissions
	Steps to install Microsoft Outlook
	Steps to download the install media

	Install the Application Features
	Install HSM
	Install Search
	Install the Archive server
	Install the Retrieve server


	Setup Address Book and Forms
	Setup up the Address Book
	Importing Exchange Servers
	Importing Mailboxes
	Importing or Creating Groups
	Synchronizing Address Book Manager

	Publish Archive Manager Forms
	Publish Forms to Organizational Forms Library
	Publish Forms to Personal Forms Library


	Installation Verification
	Enhancements
	Appendix
	Organizational Forms Library troubleshooting
	License Activation
	Registering in Microsoft Entra ID for EWS
	Starting and Stopping Services

	About Us
	Contacting Quest
	Technical Support Resources


